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1 Tutorials
The tutorials are designed to get you up and running with Fast Edit™ as soon as possible. The tutorials teach only the basic skills needed to run Fast Edit™. After you have developed these basic
skills, you will find it easy to explore all of the other features of Fast Edit™ on your own.
The tutorials are designed as follows:
1.
Starting and exiting Fast Edit™; practicing Play, Selection, Cut-and-Paste
editing, and Saving an edited soundfile.
2.
Using Markers; doing Fades and Mixes; an introduction to the Undo command,
and the Edit History List.
3.
Copying sounds to and from the multiple Clipboards.
4.
Recording with Fast Edit™.
NOTE: Mouse and keyboard methods of operation are available for most operations in Fast Edit™.
Keyboard and mouse operations are labeled with icons: ‘’ for keyboard and ‘ ’ for mouse.
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1.1 Getting Started: Playing and Editing a Soundfile
The Fast Edit™ Main Screen

Figure 1-1 Fast Edit™ Startup Window

When Fast Edit™ is first opened from Windows™, an empty window is displayed, as shown in
Figure 1-1. The main window consists of a title bar, the menu bar, and two separate sound display
windows. Each sound display window has a waveform display area, bordered above and below by
colored bars, and a set of buttons and controls at the bottom. Soundfiles that you open are displayed in the bottom window, the Read Only window. The top window is called the Modify window; this is where most editing operations are performed. In general, new soundfiles in the
Modify window are to be constructed using portions of soundfiles from the Read Only window so
that the original recordings are not altered.
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Right now the Read Only window’s upper bar is red, indicating that it is the active window;
that is, operations permitted in either window will now act on the Read Only window.

Figure 1-2 Open Dialog Box

Step 1: Copy a portion of a voice recording for editing
Open the soundfile “voice.wav”
Select the Open command from the File menu. The Open dialog box, shown in Figure
1-2, displays the soundfiles included with Fast Edit™. Click on the file entitled
“voice.wav,” then click the “OK” button. Alternatively, you can double-click on the
file.
After a very brief pause, the Read Only window will display a waveform representing the data
in the file, as shown in Figure 1-3. The name of the file is now displayed on the left side of the
Read Only window’s upper bar. On the right hand side is the amplitude scale, which is presently set at zero decibels.
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A narrow vertical line is at the center of the waveform. This is the Edit Cursor which points to
your location in the soundfile. The scroll bar at the bottom of the Read Only window confirms
that you are in the center of the soundfile, as does the time display at the lower right.

Figure 1-3 Displaying “voice.wav”

Play the soundfile
Make sure the cursor is within the Read Only waveform display area and click with
the right mouse button; however, do not click on the Edit Cursor, since this triggers a
different play operation.
A vertical bar called the play cursor moves across the display as the soundfile plays.
Play the file again and interrupt the playback.
 Type the Enter key during playback.
Play the soundfile again, pausing and unpausing the playback.
 Type the space bar repeatedly during playback.
Try this again but stop the playback while it is paused.
 Type the Enter key while playback is paused.
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When playback is stopped in this way, the Edit Cursor is moved to the location at which playback was paused. By using pause and stop during playback, you can accurately locate points of
interest in the soundfile.

Select a region
The “voice.wav” file says,
“...production work was never so easy!....harumph(throat clear)....Fast Edit...by Minnetonka Audio Software...Fast Edit...“
Our goal is to edit the voice so that it says
“Fast Edit...by Minnetonka Audio Software....production work was never so easy!”
We have one extra “Fast Edit” at the end of the soundfile. You will eliminate the extra phrase
by copying the entire window except for the extra phrase.
The first step is to move to the beginning of the soundfile.
Move the pointer over the Edit Cursor The pointer will change to a two-way arrow.
Drag the cursor to the beginning of the file (hold down the mouse button while moving the mouse). Alternatively, you can drag the scroll bar box to the left side of the
scroll bar.
It may be difficult to see the Edit Cursor in this location, but the location of the scroll bar box
and the time display reading verify that you are there.
Next, Select a portion of the soundfile, which marks a portion of the soundfile for special treatment by some function or operation.
Click the button marked ‘S’ in the lower left-hand part of the Read Only window.
The button marked ‘S’ in the lower left-hand part of the Read Only window is now highlighted, indicating that Selection is enabled. When Selection is enabled, an anchor point is
dropped at the current Edit Cursor location, and any movement of the Edit Cursor will extend
the Selection, highlighting the portion between the anchor point and the Edit Cursor.
Move the cursor to extend the Selection to the space before the unwanted phrase; the break is
approximately 6.1 seconds into the file.
Drag the cursor to the correct point in the soundfile.
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The appearance of the Selection will be as shown in Figure 1-4.

Figure 1-4 Selected Region in “voice.wav”

Play the Selection to ensure that the correct portion is Selected.
Click with the right mouse button in the middle of the Selected region.
If you have Selected the region correctly, it will say,
“...production work was never so easy!....harumph(throat clear)....Fast Edit...by Minnetonka Audio Software...“
Once the correct Selection has been made, you can duplicate it in the Modify window through
the use of the copy and Paste operations.
First, copy the Selected region.
Click the “Copy” button under the Read Only window, or select the Copy command
from the Edit menu.
The sound is now copied. Selection remains enabled in the Read Only window.
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The “Clip 1” in the row of buttons labeled “Clip 1”, “Clip 2”, “Clip 3”, “Clip 4”, and “Windows” now has a red square outlined in yellow. The red square indicates that our Selected
region is now copied into Clipboard 1.
Now you are ready to Paste the sound into the Modify window.
Click the “Paste” button under the Modify window, or select the Paste command from
the Edit menu.
Several things have now occurred as a result of the Paste, as illustrated in Figure 1-5. First, the
Modify window is now the active window, as indicated by the red upper bar. The word “Modified” appears in the bar to show that the contents of the window have been changed. The
amplitude scale is in accordance with the sound that was Pasted. Notice that there is not yet a
file name associated with the soundfile in the Modify window.

Figure 1-5 Display Windows Following the Paste Operation

The most important thing that has happened is that the sound that you have Selected and copied is now in the Modify window. An Edit Cursor now appears in this window, in the middle of
the Pasted portion of sound.
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Step 2: Select and examine a portion of the voice soundfile
Play the sound in the Modify window.
Click with the right mouse button in the Modify window.
Sounds great, except that the speaker “harrumphed” during his commentary. Next you will
delete this part of the recording.
Select the “harrumph,” which is approximately located from 2.14 seconds to 3.0 seconds in the
soundfile. The correct Selection is shown in Figure 1-6.
Drag the Edit Cursor to the space before the “harrumph,” click on the “S” button
under the Modify window to enable Selection, and then drag the Edit Cursor to the
space after the “harrumph.”

Figure 1-6 “Harrumph” Selection

To confirm that the correct Selection has been made, play the Selection.
Click with the right mouse button in the Selected portion.
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When this audible comparison is not enough to confirm that the correct region is Selected, you
can examine the Selection in more detail by zooming in and looking at a smaller range of
samples.
For now, zoom in to view the Selection you have made.
Select the View Selection Command from the Display menu.
This produces a view of the Selection with a small amount of unSelected data on either side, as
shown in Figure 1-7.

Figure 1-7 Viewing the “harrumph” Selection.

With the zoomed-in display, it is much easier to see the “harrumph” in detail. You can use the
mouse to adjust the position of both edges of the Selected region.
When the “harrumph” is accurately highlighted, you can zoom back out to the full voice
soundfile.
Select the Toggle Zoom In/Out command from the Display menu.
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Step 3: Perform edits on the voice recording
Now delete the “harrumph.”
Select the Delete command from the Edit menu.
Play the soundfile to hear the result. It should now say,
“...production work was never so easy!....Fast Edit...by Minnetonka Audio Software...“
To complete our editing of the voice, we want to rearrange the order of the two phrases from
“...production work was never so easy!....Fast Edit...by Minnetonka Audio Software...“
to
“Fast Edit...by Minnetonka Audio Software......production work was never so easy!“
To do this, you will Cut the second phrase off the end of the soundfile, and Paste it onto the
beginning of the soundfile.

Figure 1-8 Selection of Second Phrase

Play the second phrase before Selecting it.
Place the Edit Cursor where you think the second phrase begins. With the mouse
pointer still on the Edit Cursor, click on the right mouse button to play from the cur-
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sor. Move the cursor and play again, until the Edit Cursor is at the beginning of the
second phrase.
Now Select the second phrase in the soundfile. The Selection is illustrated in Figure 1-8.
Click on the “S” button under the Modify window to enable Selection, and drag the
Edit Cursor to the end of the soundfile.
Verify that the Selection is accurate by playing the Selected region. It should say
“Fast Edit...by Minnetonka Audio Software...”
When you are satisfied with the Selection, Cut it onto the clipboard.
Select the Cut command from the Edit menu.
Play the top window to hear the result. It should now say
“...production work was never so easy!”
Now Paste the contents of the clipboard at the beginning of the file.
Drag the Edit Cursor to the beginning of the soundfile, and click the ‘Paste’ button to
the left of the scroll bar or select the Paste command from the Edit menu.
Play the soundfile to hear the result. The two phrases are now reversed to say
“Fast Edit...by Minnetonka Audio Software......production work was never so easy!“
Now that the voice has been edited correctly, you will save it onto the hard drive.
Select “Save As” under the “File” menu.
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A dialog box will appear (Figure 1-9).

Figure 1-9 The Save As Dialog Box

Type “goodvoice” into the File Name box, and click on “SAVE”.
The voice in the Modify window will be saved on the disk as a soundfile named
“goodvoic.wav.” You can now verify that the sound was saved.
Select the “Open” command in the “File” menu.
You will see that “goodvoice.wav” now appears on the list of soundfiles on your hard disk.
Good job! You have completed this tutorial, and can now exit Fast Edit™.
Choose Exit from the File menu.
The next tutorial includes methods for doing Fades and Mixes, using the soundfile you just
made.
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1.2 Studio Tools: Mixing, Fading, and Fixing Mistakes
In this tutorial lesson, you will learn methods of using Markers, Mixes and Fades that will
allow you to create a final, polished product. Along the way, you will learn how to deal with
wrong turns when you are using Fast Edit™ — mistakes are easy to undo!
This tutorial follows these steps:
1.

Fade a portion of a music bed in preparation for a voice-over

2.

Mix a voice recording over the Faded music bed

3.

Fade out the promotional segment

Step 1: Fade a portion of a music bed in preparation for a
voice-over
Start Fast Edit™, and open the music recording you will be editing.
Select the Open command from the File menu.
Open the file entitled “music.wav.”
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The displayed soundfile is shown in Figure 1-10. Play it. It’s a short pattern of upbeat rock, and
will be the bed for your promo. A recorded commentary on Fast Edit™ will be Mixed over this
music..

Figure 1-10 Displaying “music.wav”

Play the music.
Click on the right mouse button in the Read Only window.
Now, copy the entire music bed to the top window. To do this, first Select the entire window.
 Move the Edit Cursor to the left side of the Read Only window. This can be done
quickly by hitting the “Home” key.
Next
turn on the Select feature by clicking on the “S” button under the window.
Then
 move the cursor to the other end of the window by hitting the “End” key.
The entire bottom window is now Selected. Copy the bottom window into the clipboard.
Click on the Copy button under the Read Only window.
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Now Paste the clipboard into the top window.
Click on the Paste button under the top window.
The entire music bed is now in the top window (Figure 1-11)

Figure 1-11 All of music.wav copied to the Modify window.

Open the edited soundfile you created in Tutorial #1.
Select Open on the File menu. Then Select the soundfile named “goodvoic.wav”.
Goodvoic.wav is now in the Read Only window. Play the soundfile.
Click the right mouse button in the Read Only window.
In constructing our promo, we will want to overlay the voice on top of the music bed. However, we will need the voice to be louder than the music so that the voice won’t be “buried” by
the music. Using Fast Edit™, we can reduce the volume of a section of the music for the
voice-over, without reducing the volume of the entire music bed.
From the Read Only window we can see that the voice track is about 5 seconds long. The
music bed, in the top window, is about 21 seconds long. So, you will want to reduce the volume of a 5-second section of the middle of the music bed.
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You will use Markers to mark a 5-second segment in the middle of the music bed.
Move the Edit Cursor to the 8-second point in the top window. Then Select Drop
Marker in the Markers menu. Marker “A” will appear at the Edit Cursor.
Move the Edit Cursor to the 13-second point and drop another Marker. This will be
Marker “B”(Figure 1-12).

Figure 1-12 Music bed with Markers.

You have identified a 5-second section of the music where the volume will be reduced for a
voice-over. In addition to reducing the volume of this section, Fast Edit™ can give smooth
Fades between the full-volume sections of music and the reduced-volume sections.

16

Let’s say you want the Fade-down to start 3 seconds before Marker “A” and the Fade-up to end
3 seconds after Marker “B”.
Place the Edit Cursor at the 5-second point. Turn on the Select feature. Select the
region from 5 seconds to 16 seconds (that is, from 3 seconds before Marker “A” to 3
seconds after Marker “B”)(see Figure 1-13).

Figure 1-13 Marking the music bed for 6-seconds of reduced volume, plus 3-seconds of
Fade-down and 3-seconds of Fade-up.

You have now identified a 5-second section of the music bed (the section between Marker “A”
and Marker “B”) where the volume will be reduced for a voice over. In addition, you have
identified 3 seconds before for a Fade-down, and 3-seconds after for a Fade-up.
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Next, set the parameters for the Fade.
Select the Fade feature in the Tools menu. The Fade Dialog box will appear (Figure
1-14).

Figure 1-14 The Fade Dialog Box.

Under Type, select Custom.
Under First Segment, select Linear.
Under Start Amplitude, select 0 dB. This means that the Selected region will start at
full volume before Fade-down.
Under End Amplitude, select 0 dB. This means that the Selected region will end at
full volume after Fade-up.
Under Markers, you will see “A” in the Name Box. Click inside of the Amplitude
Box, and type in “-12”. You are telling Fast Edit™ to reduce the volume at Marker
“A” by 12 dB. Click on the Next button. The name in the Name Box will change from
“A” to “B”. Click inside the Amplitude Box again, and type in “-12”. This tells Fast
Edit™ to reduce the volume at Marker “B” by 12 dB.
Click on the “OK” button. This will start the Fade process.
You have told Fast Edit™ to reduce the volume of the music between Markers “A” and “B” by
12 dB. You have also told Fast Edit™ to do a smooth 3-second Linear Fade-down starting at 5
seconds, and to do a smooth 3-second Linear Fade-up starting at 13 seconds.
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While the Fade operation is taking place, you will see the Fade Progress indicator in the Info
box (Figure 1-15).

Figure 1-15 Fade Progress Message box.

When it is finished, you will see the Faded music bed (Figure 1-16). Play the Faded music bed.
You will hear a smooth Fade-down from 5 seconds to 8 seconds, a steady low volume from 8
seconds to 14 seconds, and a smooth Fade-up from 13 seconds to 16 seconds.

Figure 1-16 The Faded music bed.
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You will now grab the voice from the bottom window for the voice-over.
Click inside of the Read Only window. The top of the Read Only window will turn
red. This means that the Read Only window is now the active window.
Choose the Select All under the Edit menu. The entire Read Only window will be
highlighted.
Click on the Copy button under the Read Only window.
You now have a copy of the voice in the Clipboard.
You will Mix the voice into the Faded section of the music bed.
Click on the “S” box under the top window. This will turn off the Select feature and
make the Edit Cursor available for the Mix operation.
Move the Edit Cursor to Marker “A” in the top window. This indicates that you want
the voice Mix to start at Marker “A”.
Select the Mix function from the Tools menu. The Mix Dialog Box will appear (Figure 1-17).

Figure 1-17 The Mix Dialog Box.

Adjust the level of the voice in the Mix.
Slide the Clipboard scroll bar box to set the voice to -10 dB in the Mix. Then click the
“OK” button.
While the Mix operation is taking place, you will see the Mix Progress Message box similar to
the Fade Progress Message box.
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Fast Edit™ will perform the voice-over. The result is shown in Figure 1-18. Play the top window to hear the voice-over.

Figure 1-18 The completed voice-over.

The voice sounds a little weak. No problem! We can undo our last edit operation, and re-do it.
Undo the last edit (the Mix operation).
 Hit the F-10 key.
The voice is now gone from the top window. We can re-do the Mix, but with a different volume level on the voice.
Select the Mix function in the Tools menu again. This time, set the Clipboard level to
0 dB. Then click OK.
The voice is back in the top window, but at a higher volume level. Play the top window.
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You will now perform a Fade-down on the end of the promo.
Place the Edit Cursor at 18 seconds. Turn on the Select feature.
 Hit the “End” key. The music bed will be highlighted from 18 seconds through the
end.
Select Fade from the Tools menu. When the Fade Dialog Box comes up, click on
“Fade-Out”, and then click on the “OK” button.
When the Fade operation is complete, play the entire promo. The end of the promo will Fade
out smoothly.

You have performed 5 edits:
(1) Paste the music bed to the top window
(2) Fade-with-Markers
(3) Mix the voice in the Faded music bed (later undone)
(4) Mix the voice at a higher volume
(5) Fade-out the end of the promo
Fast Edit™ remembers these 5 operations.
Select Edit History under the Display menu
The Edit History Dialog Box will come up (Figure 1-19). It shows the 5 edits you did, in
reverse order. The top line is highlighted and labeled “current”.

Figure 1-19 The Edit History Dialog Box.

22

The Edit History List allows you to go back in time to a previous point in your editing session.
Click on the Edit History line labeled “-1 Mix”. This line will become highlighted.
Then click on the Select button.
The sound in the top window will return to the way it was before your last edit operation
(before you did the Fade-out at the end). Play the top window to verify that the Fade-out at the
end has been removed.
Now, return to the Edit History List and back up one more step.
Select Display Edit History under the Display menu.
Click on the Edit History line labeled “-2 Mix undo”. Then click on the Select button.
You will see that the voice in the voice-over is quieter. Going to line “-2” takes us back to the
result of our first Mix, which was too quiet. The “undo” on this line tells you that you decided
not to keep this edit operation.
Select the “-3” line of the Edit History List. This will take you to before the first Mix, which is
to say, it take us to the point following the Fade-with-Markers operation. If you play the top
window now, you will hear the Faded music bed, but no voice-over.
Select the “-4” line in the Edit History List. This takes you to when you Pasted the music bed
into the top window. Play the top window. You will hear the unedited original music bed.
The Edit History List lets you back up as many as 10 steps. In effect, this lets you have up to 10
“undo’s” because you can back up 10 steps and start over.
What if you liked all of your edits after all? Just call up the Edit History List and select the
“current” line at the top (do this!). All of your edits will return to the top window.
Use the “Save As” command to save your promo as “mypromo”. It will be stored on the hard
drive as “mypromo.wav”.
Exit Fast Edit™ by selecting Exit under the File menu.
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1.3 Multiple Clipboards
Fast Edit™ has 4 Clipboards in addition to the Windows clipboard (see Figure 1-20). These
Clipboards are convenient temporary storage bins for soundfiles or sections of soundfiles.

Figure 1-20

Sounds are placed in the Clipboards during Copy and Cut operations.
Sounds are copied from the Clipboards during Paste and Mix operations.
Learning how to use the multiple Clipboards effectively will speed your editing sessions.
Open a soundfile.
Open the soundfile called “bark.wav”.
Copy the bark to Clipboard #2.
Click on the box labeled “Clip 2” under the top window. The “Clip 2” button is now
selected, and a yellow square will appear in the button to show that is is selected but
empty.
 Make sure the Read Only window is active and hit the “a” key to Select the entire
Read Only window.
Click on the “Copy” button under the Read Only window. A red square will appear in
button “2” to indicate that there is now a sound in Clipboard #2, and a yellow line will
surround the red square to indicate that Clipboard #2 is still the selected Clipboard.
The bark sound is now copied into Clipboard #2. Check to see that Clipboard #2 has the bark
sound.
Place the mouse pointer on the Clipboard #2 button and click on the right mouse button. It will play the contents of Clipboard #2.
Open the soundfile “bell.wav”. Place it into Clipboard #1. Check to see that the bell sound is in
Clipboard #1.
Place the soundfile “buzzer.wav” into Clipboard #3, and the soundfile “crash.wav” into Clipboard #4.
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Now, select Clipboard #1.
Click on button “1”. A yellow line will surround the red square to show that Clipboard #1 is selected.
Paste the contents of Clipboard #1 into the top window.
Click on the Paste button.
The bell sound will appear in the top window (Figure 1-21). Play the top window.

Figure 1-21 The bell sound is Pasted to into the top window from Clipboard #1.

Next, Paste the crash sound into the top window after the bell sound.
 Hit the “End” key to move the Edit Cursor to the right side of the top window.
Click on button “4”. Clipboard #4 is now selected.
Click on the Paste button.
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The crash sound will be Pasted into the top window after the bell sound (Figure 1-22). Play the
top window.

Figure 1-22 The crash sound is Pasted into the top window after the bell sound.

Now, clear the top window by closing it.
Select Close in the File menu.
A dialog box will appear asking if you want to save the sound in the top window (Figure 1-23).

Figure 1-23

Select “No”.
The top window is now empty.
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Experiment with pasting the contents of the other two Clipboards into the top window. When
you are finished, exit Fast Edit™.
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1.4 Recording
Recording sounds into Fast Edit™ is very much like recording sounds into a tape recorder. The
main difference is that each sound recorded into Fast Edit™ must be given a file name.
To use this tutorial, you will need a line-level signal connected to the inputs of your audio card.
The outputs of a CD-player would be a good choice for this.
Call up the Record function.
Select Record from the File menu of Fast Edit™.
A dialog box will appear (Figure 1-24), asking you for a file name.

Figure 1-24 The Recording Name Dialog Box.

 Type “mysound”.
Click on “OK”.
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The Record Dialog Box will appear (Figure 1-25). If you are feeding an audio signal into your
audio card, you will see the level meters moving. Also, depending on which audio card you
have, you may be able to monitor the sound through the outputs of your audio card.

Figure 1-25 The Record Dialog Box.

The Record Dialog Box also displays the name of the soundfile you will be recording, the sample rate, the elapsed time of the recording, and the total remaining recording time on your hard
disk. The elapsed time will be 00:00:00.0 since you haven’t started the recording yet.
If you see the meters working, you can begin your recording.
Click on the Record button.
The Elapsed Time display will start counting. After about 15 seconds, stop the recording.
Click on the Stop button.
Now exit the Record Dialog Box to display your recording.
Click on the Close button.
Your new recording will be displayed in the Read Only window. You can now play your
recording from the hard disk.
Click the right mouse button in the Read Only window.
Next, check to see that your new recording is on the list of soundfiles on the hard disk.
Select Open from the File menu.
Look in the file list for “mysound.wav”.
When you are finished, you may exit Fast Edit™.
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2 Fast Edit™ - Functional Reference
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2.1 Fast Edit™ Screen
Fast Edit™ uses a split-screen waveform display to make non-destructive editing fast and intuitive.

Figure 2-1 The Fast Edit™ Main Screen

2.1.1 The Read-Only and Modify windows
The split-screen Fast Edit™ (Figure 2-1) has a top window and a bottom window, both for
waveform display. The top window is called the Modify window, and is the window where
editing operations take place. The bottom window is the Read Only window, and soundfiles are
opened into the bottom window, where they can be played or copied without any damage or
alterations to the original recordings. Generally, soundfiles are opened into the bottom window,
and parts of soundfiles are copied into the top window, where the new, edited soundfile is
constructed.
There are a number of features common to both the Modify window and the Read Only
window:
A bar spans the top of each window and indicates the name of the currently displayed sound file
at its left side and the amplitude scale of the currently displayed sound file at its right side. The
bar above the active window is red, and the other window’s is blue. When a stereo sound is
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displayed, the left channel is displayed above the right channel, with a horizontal dotted line
separating the two. When a mono sound is displayed, a single waveform appears in the window.
There are several differences between the top and bottom window, all related to the distinctive
functions of the two windows. The bottom window is the Read Only window and the title
“Read Only” appears permanently in the center of its upper bar. A sound file in the Read Only
window is protected from change in any way, but all display and playback functions operate
normally.
The top window is the Modify window. In addition to display and playback features, the full
editing and processing capabilities of Fast Edit™ are available in the Modify window. The title
“Modified” appears in the center of its upper bar when its contents have been changed.
Clicking the mouse in either window will make that window the active window. The active
window can also be selected using the up- or down-arrow keys, or the F3 key.
Under each window is a set of control buttons (see Section 2.1.2.1, “Control buttons,” on
page 34

2.1.2 The Transport Bar and Control Buttons
Between the Modify window and the Read-Only window are a number of controls and status
indicators, called the Transport Bar. The Transport Bar includes the Clipboards window, the
Transport and time display, the List of Active Plug-ins, and the Info window.
Control buttons

Clipboards

Transport and time

Scroll bar

List of active
plug-ins

General info and
progress indicator

Figure 2-2 Transport Bar and Control Buttons

The Transport Bar can be shown or hidden. The Show/Hide Transport option is in the Display
menu, near the bottom.
Immediately above the Transport Bar are the Control Buttons for the top window. Some of the
controls are duplicated under the Read-Only window
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2.1.2.1 Control buttons
Figure 2-3 shows the control buttons under the Modify window.
Zoom out

Selection

Lock waveforms

Paste

Zoom in
Looped playback

Automatic crossfades

Copy

Figure 2-3

Zoom in and zoom out - horizontally zooms the waveform by a factor of 2.
Looped playback - continuously plays a selected area.
Selection - turns on the selection tool, so that dragging the edit cursor marks a section of a
waveform. If selection is already on, this button turns it off.
Automatic crossfades - turns the automatic crossfade feature on and off. Automatic crossfades are used to de-glitch edits (see Section 2.8.4, “The Automatic Crossfade Option,” on
page 70.
Lock waveforms puts the top and bottom windows onto identical timescales, and operates the
edit cursor across both windows at the same time (see section 2.1.4, Lock Waveforms).
Copy - copies a selected area into the clipboard.
Paste - pastes the sound from the clipboard into the Modify window.

2.1.2.2 Scroll bar
Figure 2-4 shows the scroll bar.

Figure 2-4

The top part of the scroll bar positions the cursor in the waveform window. The thin line
under the scroll bar is used to indicate how far you are zoomed in, and where you are in the
waveform. For instance. the gray area is about 1/4 of the total length, and it is in the middle.
This means that you are zoomed in to show 1/4 of the total waveform, and you are showing
the section that is in the middle of the total waveform.
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2.1.2.3 Clipboards
Figure 2-6 shows the Clipboards.

Figure 2-5

Fast Edit™ has 5 Clipboards indicated by the 5 buttons in the "Clips" window. Clipboards are
a convenient place for the temporary storage of sounds.
When the button is gray, it has no sound stored, and it is not selected.
When the button is yellow, it is selected but has no sound.
When the button is red, it has a sound stored, but it is not selected.
When the button is red with a yellow outline, it is selected and has a stored sound.

2.1.2.4 Transport and time
Figure 2-6 shows the transport and time window.

Figure 2-6

The transport buttons are rewind, stop, play, pause, fast forward, and record.
The time indicated is the time at the Play Cursor when Fast Edit™ is Playing, and the time at
the Edit Cursor when Fast Edit™ is not Playing.

2.1.2.5 Plug-ins window
Figure 2-7 shows the plug-ins window.

Figure 2-7
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This window lists the DirectX™ plug-ins that are currently active.

2.1.2.6 Info window
Figure 2-8 shows the info window.

Figure 2-8

This window displays information about the soundfiles in the active waveform display window. During the use of tools, the window displays a progress meter.

2.1.3 Moving the Edit Cursor
When a sound file is opened, a vertical line appears in the middle of the waveform display area.
This line is the Edit Cursor, which points to a specific sample in the waveform. The Edit Cursor
is moved by dragging it with the mouse.
To grab the Edit Cursor, first move the mouse pointer to the Edit Cursor. When the mouse
pointer is at the Edit Cursor, it will change from a diagonal arrow to a horizontal double arrow,
or, if the Edit Cursor is near the edge of the window, it will turn into a single horizontal side
arrow (Figure 2-9).

Figure 2-9 Near the Edit Cursor, the mouse pointer changes to a double side arrow, or a single
side arrow.

When the cursor is a single or double side arrow, you can hold down the left mouse button and
drag the cursor.
The cursor can also be moved with the left and right arrow keys. To move the Edit Cursor
quickly with an arrow key, hold down the Cntl button and then hit the arrow key.
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The Edit Cursor can be moved using the Scroll Bar underneath the waveform display (see
Figure 2-10).

gray area

left arrow button

scroll button

right arrow button

Figure 2-10

You can grab the scroll button and drag it to the left or to the right to move the Edit Cursor to the
left or right. Also, you can click on the left or right arrow button to make the Edit Cursor move
a very small step to the left or right. If you hold down one of the arrow buttons, it will repeat,
moving the Edit Cursor smoothly to the left or right.
If you click in the gray area to the right of the scroll button, the waveform display will scroll to
the right. If you click in the gray area to the left of the scroll button, the waveform display will
scroll to the left.
The Edit Cursor can be made to jump to the left side of the window using the Home key, and
will jump to the right side of the window using the End key.
A “splice point” is the location where an edit operation has occurred in the top window. During
editing, it is often helpful to return to an exact splice point for another edit operation. Fast
Edit™ remembers these points. Using the “<“ and “>” keys will make the Edit Cursor jump left
or right to the nearest splice point.
When markers have been used in the window, the Tab key and the Shift-Tab key can be used to
make the Edit Cursor jump right or left to the nearest marker. Markers are discussed in
section 2.6, Markers.
A special feature lets you grab the Edit Cursor quickly, no matter where it is. Just move the
mouse pointer to where you want the Edit Cursor to be, and double click the mouse. The Edit
Cursor will snap to the mouse pointer.

2.1.4 Lock Waveforms
When you click on the "Lock waveforms" button (see section 2.1.2, The Transport Bar and
Control Buttons) or select "Lock waveforms" under the Display menu, Fast Edit adjusts the
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timescales of the top and bottom windows to be indentical. It will add silence onto the end of
one of the windows if necessary to make the timescales match (see Figure 2-11).

Figure 2-11 Locked waveforms

"Lock waveforms" also causes the edit cursor to be active across both windows at the same
time.
"Lock waveforms" makes it easy to compare the timing of sound segments between the two
windows, for instance, when doing voice-over work.
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2.2 Files
2.2.1 Opening Files
Soundfiles on the hard disk can be displayed in Fast Edit™ by using the Open command. This
brings up the Open Dialog Box (Figure 2-12).

Figure 2-12 Open Dialog Box

Fast Edit™ uses a standard Windows "Open" dialog.
When you open a soundfile, it is displayed in the Read Only window. Sounds from this file are
now available for your editing work, without altering the original soundfile.
If you intentionally want to do a destructive edit (that is, alter an existing soundfile), you can
use the “Open for Modify” command. This command will load the soundfile into the Modify
window. You can now modify the soundfile, and then use the “Save” command to replace the
original soundfile with the modified soundfile. The original soundfile is not altered until the
“Save” command is used to rewrite the file.
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2.2.2 Saving a Soundfile
When you have finished an editing session, and you want to save your work, you can use the
“Save As” command. A dialog box will appear to ask you for a soundfile name (Figure 2-13).

Figure 2-13 The Save As command asks you for a soundfile name.

When you type in a soundfile name and click on “SAVE”, Fast Edit™ will convert the entire
Modify window into a new soundfile, and store it under the name you gave it, but with a “.wav”
extension added.
If you gave it the name of an existing soundfile, a dialog box will appear to warn you (Figure
2-14). You will then need to select whether you want the existing soundfile to be written over
(i.e. replaced by the new soundfile).

Figure 2-14 If you choose an existing soundfile name for the Save As command, it will warn you
that you would be overwriting an existing soundfile.

If you are doing destructive editing using the Open for Modify command, you can save your
modifications by using the Save command. It will remember the name of the file that was
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opened into the Modify window, and automatically overwrite the original soundfile when the
Save command is used.
If you are saving with the “Save Selection” command, a dialog box will appear to ask you for a
soundfile name. You can save selected portions of soundfiles from either the Read Only
window or the Modify window. If you are saving a selection from the Read Only window, you
are not allowed to overwrite an existing file.

2.2.3 Closing Soundfiles
The Close command is used to clear the Modify or Read Only window, whichever is active. If
the top window is active, and a sound is displayed in the top window, Fast Edit™ will ask you if
you want to save the sound (Figure 2-15).

Figure 2-15 When you close the top window, Fast Edit™ will ask you if you want to save the
sound.

The “New” command works like the Close command, but it only works on the Modify window.

2.2.4 Deleting Soundfiles
It is always best to delete unwanted soundfiles using Fast Edit’s™ “Delete Soundfile”
command, than to do it from DOS or Windows. The Delete Soundfile command not only
deletes the soundfile, but also the associated metasample file.
Also, if the soundfile is necessary for an Editlist, Fast Edit™ will warn you before you delete it
(see section 2.2.8, Editlists).
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2.2.5 Recording Soundfiles
The “Record” command on the “File” menu produces the Record File dialog box which
includes fields similar to those in the Open dialog box (see Figure 2-12 on page 39) for setting
the file name and path for the new sound file.

Figure 2-16

Record Dialog Box.

Next, a Record Dialog Box appears (see Figure 2-16). The name of the file being recorded is
displayed, along with the current sample rate, sample size, and channel settings. The elapsed
time of the recording is displayed, as well as the total remaining time available on the hard
drive.
The level meters indicate the amplitude of the input signal. When recording a Mono source, the
sound is sampled from the left channel only, and the right channel is disabled. The meters are
green up to 6 dB below clipping, and then yellow up to the clipping level, which is red. The red
clipping indicator is displayed each time the maximum sample value is detected, and remains
on the level display for a few seconds.
The "Stop recording after" dialog lets you put a time limit on recordings. When you put a check
mark in the box, the total recording time is limited to the time set in the 3 boxes (hours, minutes,
and seconds). You can change the times by typing new times into the boxes, or by clicking the
up/down arrows next to each box. Clicking on the Reset button sets all the numbers back to
zero.
When the Record dialog box appears, recording has not yet started, although the level meters
will be active. Recording starts when you click on the Record button, and stops when you click
on the stop button. If you click on the Record button again, the recording will resume.
Markers are dropped during recording with the Drop Marker button (see section 2.6.1, Creating
and Modifying Markers).
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The Close button ends the record session. The new soundfile is opened in the Read Only sound
display window, along with any markers that may have been placed.
Recording can be made to stop automatically after a predetermined amount of recording time.
To do this, place a check in the "Stop Recording After" box, and select a time in the hours,
minutes, and seconds windows below.

2.2.6 Simultaneous Play and Record
The Simultaneous Play and Record feature of Fast Edit™ lets you listen to one stereo soundfile
while recording another. For instance, if you are producing a voice-over, you can listen to the
music bed while you are recording the voice track.
First, you put the recording that you want to listen to into the top window. Next you call up Play
and Record, in the Files menu. A window asks you for a filename for the recording you are
about to make. Then a Record Dialog box comes up (see Figure 2-17.).

Figure 2-17 The Record/Play Dialog Box

At first, the bottom line of the Dialog Box says “Press Queue Record to enable recording.”
When you click on the Queue Record button, the bottom line changes to “Press Start or play
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waveform to begin recording.” At this point, you can either click on the Start Record button, or
you can start the playback of the bottom window by any usual method, such as clicking inside
the bottom window with the right mouse button.
Playback and recording will both start immediately. The outputs of your soundcard will play
back the top window, but will not monitor the inputs. If you want to monitor the inputs at the
same time, you will need to do this through your mixing board.
When you have finished recording, you must manually stop the recording. Do this by clicking
on the Stop button, or hit the Enter key. The new recording will appear in the bottom window.

2.2.7 Sample Rate selection
The sample rate, sample size and channel are set using the Sample Rate/Channels command in
the Options dialog, which you will find at the bottom of the Display menu (see Figure 2-18).

Figure 2-18 The Sample Rate dialog

2.2.8 Editlists
Editlists are a feature of Fast Edit™ designed to save time and disk space.
In cut-and-paste editing, the entire sound in the Modify window is a duplicate of sounds in the
other soundfiles from which they were copied. Rather than saving the top window as a soundfile, which will take time and disk space to duplicate the sounds from all the original source
soundfiles, the Editlist feature saves the Modify window as a very short file of pointers to those
sound segments in the original soundfiles. As long as all the original source soundfiles are on
the hard disk, and not altered, the edited sound can be reloaded as an Editlist.
Saving the Modify window as an Editlist is most useful when the editing is primarily
cut-and-paste. It is less useful in saving time and disk space when the editing contains long
segments of Mixes, Fades, Crossfades, EQ, Sample Reversal, Gain Change and Normalize.
When you save an Editlist, Fast Edit™ remembers all of the original soundfiles that the Editlist
refers to. Also, Fast Edit™ saves all of the temporary files that are necessary to reload the
Editlist.
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If you use Editlists, always be sure to use Fast Edit™ anytime that you want to delete unwanted
soundfiles. The Delete Soundfile command will warn you if the soundfile you want to delete is
necessary for the reloading of one of your saved Editlists.
To save the Modify window as an Editlist, choose the “Save Editlist” command in the File
menu. A dialog box will appear that will ask you for a name for your Editlist. The Editlist will
be stored on the hard disk using your name, with a “.els” filename extension.
The “Load Editlist” command works very much like the Open command works for soundfiles.
The Load Editlist Dialog Box (Figure 2-19) lists all files in the directory that have the “.els”
filename extension.

Figure 2-19 The Load Editlist Dialog Box.

The Editlist will load into either the Modify window or the Read Only window, whichever is
active.
Whenever you want to delete an Editlist, it is important to use the “Delete Editlist” command in
the File menu. This command not only deletes the Editlist selected, but also notifies the appropriate soundfiles that they are no longer referenced by the Editlist being deleted. The Delete
Editlist also deletes any temporary soundfiles that were needed for the Editlist.

2.2.9 Exiting Fast Edit™
To exit Fast Edit™, select Exit under the Files menu, or double click on the upper left-hand
corner of the main Fast Edit™ screen. If you have an edited sound in the Modify window, Fast
Edit™ will ask you if you want to save it to a soundfile.
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2.3 Editing Sound Files
2.3.1 Selecting the Active Window
The split-screen Fast Edit™ waveform editor has 2 sound display windows. In general, soundfiles are opened into the bottom, or Read Only, window to be viewed and auditioned. Soundfiles and selected parts of soundfiles are copied into the top, or Modify, window where edit
operations are allowed.
At any given time, only one of the windows is active. When a window is active, the bar across
the top of that window is Red. You can make the Read Only the active window, or make the
Modify window the active window, by placing the mouse pointer inside of the desired window,
and clicking the mouse.
Also, you can use the up-arrow to select the Modify window, and the down-arrow to select the
Read Only window. The F3 key switches from whichever window is active, to the other
window.
When the Read-Only window is active, the editing functions which are not allowed in the Read
Only window will not be available in the menus. This includes destructive operations like Cut
and Mix.

2.3.2 Making Selections in the Waveform Display Area
When you want to use part of a soundfile for an edit operation, you can indicate what section to
use by doing a “Selection”. To Select a part of a soundfile, you use the “Select” feature to highlight a section of the waveform display in either the Modify or Read Only window.
To Select a region, move the Edit Cursor to the beginning of the region you want to select. Then
use the mouse to click on the “s” button beneath the window. The “s” button will become highlighted when the Select feature is active. When selection is initially enabled, an anchor is
“dropped” at the current Edit Cursor location, defining the unmoving edge of the selection; the
Edit Cursor defines the other edge as it is moved. The waveform display between the anchor
point and the current Edit Cursor position is highlighted, showing the Selected region.
The mouse can now be used to grab either side of a Selected region, and adjust the location. The
side that is adjusted last becomes the active Edit Cursor.
When the Select feature is turned off again, the highlighted region of the waveform display
returns to normal (no longer highlighted), and the Edit Cursor appears at the last active Edit
Cursor position on the previously highlighted region.
The Select feature can also be operated from the keyboard. The F9 key turns Select on and off.
The Edit Cursor can be moved with the left and right arrow keys, and the active Edit Cursor can
be switched between the two sides of the Selected region using the "i” key, or by using the “b”
key to place the active Edit Cursor at the “b”eginnning of the selected region, or the “e” key to
place it at the “e”nd.
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The entire soundfile can be selected by hitting the “a” key (for Select “a”ll). If the display was
zoomed-in, the “a” key will zoom-out the display to show the entire soundfile, and select the
entire soundfile. If the “a” key is hit again, the Select feature will be turned off.
There is also a quick-Select feature with the mouse. Place the Edit Cursor on one side of the
desired Selected region. Then move the mouse pointer to where you want the other side of the
selected region to be. Hold down the left mouse button while you click on the right mouse
button. A highlighted region will appear between the Edit Cursor and the mouse pointer.

2.3.3 Cut-and-Paste Editing
Cut-and-paste editing is the most basic type of editing, and involves moving around pieces of
sound.
Sounds from the Read Only window can only be Copied. A segment of sound is Selected, and
the sound is copied into the Clipboard for use in the Modify window.
Sounds in the Modify window can be Copied, Cut, Pasted, Replaced, and Deleted.
The Copy command takes the Selected sound in the active window and copies it to the Clipboard. This copy of the sound in the Clipboard can be used at a later time for other operations.
The Paste command takes the sound in the Clipboard and copies it into the Modify window at
the location of the Edit Cursor. If the Edit Cursor is in the middle of some sound in the top
window, the Paste feature splits the sound apart at the Edit Cursor, and inserts the Clipboard
sound in between.
The Delete command removes the Selected sound in the Modify window. If the Selected sound
was in the middle of a soundfile, the remaining sound will be pulled together to close the gap
left by the Deleted sound.
The Cut command deletes the Selected sound, and at the same time makes a copy of the sound
in the Clipboard. The Cut command makes it easy to remove a sound from one part of a soundfile, and move it to another part of the soundfile.
The Copy-Paste command is a special combined command to speed up editing. The Copy-Paste
command will take the selected region in the Read Only window, or the entire window if no
region is selected, and copy it into the Clipboard. At the same time, it will also paste it into the
Modify window, at the location of the Edit Cursor.
The Replace command takes the sound in the clipboard, and replaces an equal-length segment
of sound in the Modify window, starting at the location of the Edit Cursor.
The Move command is a special type of cut-and-paste editing. It makes it easy to move a sound
from one place in a soundfile to another place.
To use the Move command, first Select the sound you want to Move. Then call up the Move
command, by either selecting it from the Edit menu, or by hitting Shift+V on the keyboard.
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Next, grab the selected sound by putting the mouse pointer anywhere inside the Selected region,
and holding down the left mouse button. An outline of the selected region will appear. Move the
mouse to slide the Selected region horizontally in the window, to the new location, and release
the mouse button.
The old location of the sound will be replaced by a piece of silence, of equal length. If the
Moved sound is put over the top of another sound, that sound will be replaced by the Moved
sound. The Move operation moves a sound without changing the total length of the soundfile.

2.3.4 Punch In
The Punch In command lets you record over a preselected section of a soundfile in the top
window.
To use the Punch In operation, first Select the region of sound to be re-recorded. Then call up
the Punch In command by either selecting it from the Edit menu, or by hitting Ctrl+f on the
keyboard. A set of level meters will appear on the screen, and the system will be cued for a
playback with Punch In.
To do the Punch In, start the playback of the top window. Fast Edit™ will play the window up
to the Selected region, then it will instantly go into Record mode through the Selected region,
and then will go back to Playback immediately following the Selected region. When playback is
completed, the Selected region will be re-drawn with the newly recorded sound.
When doing a Punch In, it is not necessary to start playback from the beginning of the soundfile. When you go into Punch In mode, a cursor appears to the left of the Selected region. This is
the Start Playback Cursor. During a Punch In, you can start playback from this cursor by putting
the mouse pointer over the cursor, and clicking on the right mouse button. The initial position of
the Start Playback cursor, relative to the Selected region, is determined by the Audition Time
option (see section 2.8.2, Record and Playback Options). The position of the Start Playback
Cursor can be adjusted by grabbing it with the mouse and sliding it to a new position.

2.3.5 Mute
The Mute function replaces a sound with silence. To use the Mute, first Select the region to be
silenced. Then call up the Mute function by selecting it from the Edit menu, or by hitting Ctrl+t
on the keyboard. The Selected region will be replaced by a section of silence of equal length.
The Mute funcion does not change the length of the soundfile.

2.3.6 Insert Silence
The Insert Silence function will add silence at the edit cursor position, increasing the length of
the soundfile. The amount of silence that is added is selected by a dialog, where either a fixed
duration may be specified or the length of the selected region may be used. If the check box
labelled “Insert Fixed Duration” is checked, the specified duration is inserted. Otherwise, the
length of the selected region is used to specify the amount of silence to insert.
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Note that the silence will be inserted at the edit cursor location, which may be at the beginning
or end of a selected region.

2.3.7 Multiple Clipboards
Fast Edit™ has 4 general-purpose Clipboards plus a Windows Clipboard. Each Clipboard can
be used to temporarily store a sound saved from either the Modify window or the Read Only
window. The Windows Clipboard can be used to transfer sounds between programs.

Figure 2-20

Only one Clipboard is active at any given time. You can select the active Clipboard by clicking
on the Clipboard button on Fast Edit™ screen (see Figure 2-20). The active Clipboard is highlighted. All functions that use the Clipboard use the Clipboard which is currently active.
Button colors

Clipboard status

gray

Clipboard empty and not selected

yellow

Clipboard selected but empty

red

Clipboard has sound but is not selected

red with yellow outline

Clipboard has sound and is selected

You can audition any sound stored in a Clipboard by right-clicking on the button.

2.3.8 Locating Splice Points
Anytime an edit operation is performed in the Modify window, Fast Edit™ remembers the location in the soundfile where the edit took place. These locations are called Splice Points. When
one sound is pasted to another sound, for instance, the location where they come together is a
Splice Point.
Finding Splice Points can speed your edit operations. Splice points can be located easily with
the Next Splice and the Previous Splice commands. The Next Splice jumps the Edit Cursor to
the right, to the next splice point. The Previous Splice command jumps the Edit Cursor to the
left.

2.3.9 Undo
Fast Edit™ uses fully non-destructive editing. Because of this, Fast Edit™ can remember the
sound in the Modify window before your last edit operation.
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When you don’t like the result of and edit operation, you can use the Undo command, and the
Modify window will return to exactly the way it was before the edit operation.
Fast Edit™ lets you perform up to 10 Undos.
You can select "Undo" off the edit menu, or hit F10 on your keyboard.
To undo more than one edit operation, you can also use the Edit History List (see section
Section 2.7.5, “Undo and the Edit History”).
What if, after you Undo an edit operation you change your mind, and decide you liked it after
all? Just use the Redo command (see ).

2.3.10 Redo
If you perform and Undo to get rid of your last edit operation, and then change you mind, you
can bring it back with the Redo command.
You can select Redo from the Edit menu, or hit F11 on your keyboard.
If you have done multiple Undos, you can do multiple Redos.
You can also use the Edit History List to perfom Redos (seeSection 2.7.5, “Undo and the Edit
History”).

50

2.4 Playing Sound Files
Fast Edit™ provides many ways to playback sounds from the sound display windows. All playback functions work the same for the Read Only window and the Modify window. Keyboard and
menu playback functions play from whichever window is active.

2.4.1 Methods of Sound Playback
To playback the entire sound in a window, place the mouse pointer inside that window and click
the right mouse button. The sound in the window will play, as a thin vertical line moves across
the window to indicate the part of the window that is being played. This vertical line is the Play
Cursor.
The entire sound in the window can also be played with the “p” or the “F4” key on the
keyboard. A major difference is that, if a part of the sound is Selected, only the selected sound
will play. You can also play a Selected area by right-clicking inside the Selected area.
The “f” key will play the entire soundfile, even if the window is zoomed-in, and not all of the
soundfile is displayed.
Anytime during playback, the playback can be stopped by hitting the “Enter” key on the
keyboard. Clicking the right mouse button during playback has the same effect.
Also, anytime during playback, the playback can be paused by hitting the “Space” bar on the
keyboard. The Play Cursor will stop on the screen, at the point where the playback was paused.
Playback can be resumed by hitting the “Space” bar again.
If the “Enter” key is hit while playback is paused, the Edit Cursor will jump to the location of
the Play Cursor. This can be very useful in locating points for editing.
The Edit Cursor can be used to indicate where to begin playback. To play from the Edit Cursor,
place the mouse pointer over the Edit Cursor (the mouse pointer will change to a single or
double side arrow). Then click the right mouse button. The Play Cursor will start from the location of the Edit Cursor.
Fast Edit™ has a feature called Audition Play, which helps you fine-tune your edits. If a region
is Selected, you can use audition play by placing the mouse cursor on the edge of the Selected
region. If you are on the left edge of the selected region, playback will start at the beginning of
the Selected region and play for a short time, and then stop. If you are on the right edge of the
Selected region, playback will start a short time before the end of the Selected region, and play
up to the end to the Selected region, and then stop. The time of the Audition Play is set in the
Record/Playback page of the Options window, which you will find at the bottom of the Display
menu (see section 2.8.2).
If a region is Selected, the Audition Play can also be performed with the “Alt-p” key on the
keyboard. It will also play from the left side of the Selection, or up to the right side of the Selection, depending on which side of the Selection has the active Edit Cursor.
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“Alt-p” will also do an Audition play at the Edit Cursor, if there is no region Selected. Playback
will go from a short time before the Edit Cursor to a short time after the Edit Cursor.
The contents of the 5 Clipboards can be played. Just point the mouse to the desired Clipboard
button, and click on the right mouse button.
Playback can also be looped indefinitely by selecting Loop Playback (select Loop Playback by
clicking on the button marked "L" at the bottom of each window). The entire waveform or a
selected area may be looped. When looping a selected area, sides of the selected area can be
adjusted during Playback

2.4.2 Looped Playback
Fast Edit™ can do a continuous repeating playback of a section of audio. To do looped playback, you must first do a Selection of the sound to be looped.
Next, click on the Loop Playback button (marked "L") at the bottom of the window you want to
play.
Then right-click inside of the Selected area. Playback will start at the beginning of the Selected
area, and will play the entire Selected area. The Playback cursor will then immediately jump
back to the beginning of the Selected area and play it again.
To turn off Looped Playback, click on the Loop Playback button again.

2.4.3 Scrub
Fast Edit™ lets you Scrub a section of the waveform, using the mouse, in order to audibly
locate the beginning of any particular sound.
To use Scrub, first place the Edit Cursor in the approximate location of the sound you want to
Scrub. Then call up the Scrub funtion by selecting it from the Play menu, or by hitting F2 on the
keyboard. The window will zoom in or out to show a few seconds of sound around the Edit
Cursor. To perform the Scrub, grab the Edit Cursor with the right mouse button, and slide the
cursor horizontally. Fast Edit™ will play the waveforms as the cursor moves over them. It can
play in real time, faster than real time, and slower than real time, depending on how fast you
move the cursor. It can also play forwards and backwards.
The amount of time displayed during Scrub is set by the Scrub Time Option, in the Record and
Playback section of the Options window, which you will find at the bottom of the Display menu
(see section 2.8.2, Record and Playback Options).
When you have finished Scrubbing, you can return to the normal display by hitting the left
mouse button.
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2.5 Tools
Fast Edit™ includes eight tools for processing sound files. Each tool produces a message box that
indicates progress during time-consuming operations. The progress is shown as a percentage of
the operation completed up to that point. There is also a “Cancel” button in the box; if you click
on the “Cancel” button, Fast Edit™ will cancel the operation, and the Progress Dialog Box will
disappear.

2.5.1 The Mix Tool
The mix tool mixes the sound in the Clipboard with the sound in the Modify window, beginning
at the Edit Cursor location.
When the Mix tool is selected, the Mix Amplitudes Dialog Box appears (Figure 2-21). This
dialog box lets you set the levels on the two sounds being mixed together. The “Destination”
slider adjusts the volume on the sound from the Modify window, and the “Clipboard” slider
adjusts the volume of the sound taken from the Clipboard.

Figure 2-21

Mix Amplitudes Dialog Box

2.5.2 The Fade Tool
The fade tool is used to make smooth volume changes in a sound.
In it’s simplest use, the Fade tool will be used for a fade-in or a fade-out; for instance to fade-in
the beginning or fade-out the end of a song. To use a simple fade-in or fade-out, Select the part
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of the sound over which the fade is to occur. Then select Fade from the Tools menu, click on the
“Fade In” or the “Fade Out” in the Fade Dialog Box (Figure 2-22), and then click on “OK”.

Figure 2-22 Performing a simple fade-in.

For more complicated fades, markers can be used to help draw a customized fade curve. To do a
customized fade, you must first drop markers in the Modify window. Then you use the Selection tool to select the part of the waveform that you want to perform a fade on. If you do not
Select an area, the Fade tool will work on the entire top window. When you select the fade tool,
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you will set the level at each marker, and Fast Edit™ will do smooth fades between adjacent
markers, and between the endpoints and the nearest markers (Figure 2-23).

Figure 2-23

Performing a custom fade

In the Fade Dialog Box, the fade profile is displayed at the top and is updated to reflect any
changes made.
The amplitudes at the starting and ending fade points are defined with the buttons in the Start
Amplitude and End Amplitude regions. When you click on the Fade In button under Type, the
Start Amplitude is set to -∞ dB, and the End Amplitude is set to 0 dB. When you click on the
Fade Out button, the Start Amplitude is set to 0 dB, and the End Amplitude is set to -∞ dB.
When you click on the Custom button, you can manually set the Start Amplitude and End
Amplitude.
The amplitudes at the marker locations are set in the Markers region in the Amplitude field. The
first marker will be shown in the Name box. Click in the Amplitude box to type in the level, in
dB’s, at the marker position. Any integer value in the range -48 dB and 12 dB is valid. If a
marker’s amplitude value is deleted, that marker ceases to be a fade point. Then select “log” or
“linear” to define the type of curve after the marker. Then click on the Next button. The name of
the next marker will appear in the Name box. Once the levels at all of the markers are defined,
the customized fade curve will appear at the top of the Fade Dialog Box.
The type of curve for the segment before the first marker is set under “First Segment”.
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When you have your custom fade set up, click on the “OK” button, and Fast Edit™ will process
your fade.

2.5.3 The Manual Crossfade Tool
The Manual Crossfade tool is useful when you want to overlap 2 sounds, with one sound fading
out as the other fades in.
In its simplest use, you place the Edit Cursor in the Modify Window between the two sounds
you want to crossfade. Then you select Manual Crossfade in the Tools menu. When the Manual
Crossfade Dialog Box comes up (Figure 2-24), type in the crossfade Duration (the length of
time that the sounds will overlap, in milliseconds). Then select Linear or Log crossfade curves,
and click on OK.

Figure 2-24

Manual Crossfade Dialog Box

You can customize your crossfades by entering times in the Custom Parameters boxes. The top
of the Manual Crossfade Dialog Box shows you the profiles of the crossfade curves you are
creating.
The Fade Out Time and Fade In Time values set the amount of sound before and after the Edit
Cursor that will be affected by the crrossfade. The Fade Out Start Time and Fade In Start Time
values set a delay for the two fades.
If you type a new number in the Duration box, the numbers in the Custom Parameters boxes are
automatically reset.
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When the crossfade operation has completed, the Edit Cursor is placed at the splice point at the
beginning of the crossfaded portion of the sound file.

2.5.4 The Reverse Tool
This tool’s function is simply to reverse the samples in the affected portion, causing the sound
to be played backwards. Unlike the other tools, the reverse tool operates immediately on a
sound file, or on a Selected region, if there is one.

2.5.5 The Gearshift Tool
The Gearshift tool has the same effect as speeding up or slowing down a tape on an analog tape
machine (varispeed). When you call up the Gearshift function, the Gearshift Dialog Box
appears (Figure 2-25).

Figure 2-25

Gearshift Dialog Box

You can move the slider bar or type in a value to set the Gearshift amount. When you set Gearshift to a positive value, playback will speed up, resulting in a higher pitch, and a shorter playback time. When you set the Gearshift to a negative value, playback will slow down, resulting
in a lower pitch, and a longer playback time.
Gearshift will work on the Selected region in the Modify window, if there is one. Otherwise, it
will work on the entire Modify window.
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2.5.6 The EQ Tool
The EQ tool provides bass and treble shelving EQ.

Figure 2-26

EQ Dialog Box

When the EQ tool is selected, the EQ Dialog Box appears (Figure 2-26). You can set the bass
and/or treble to have a boost or cut of up to 20 dB. The shelf-edge frequencies can be set from 1
Hz to 1000 Hz for the bass, and 1000 Hz to 20,000 Hz for the treble. A typical value for the bass
frequency might be 50 Hz, and a commonly used value for the treble frequency might be 10,000
Hz (for recordings with 44.1 kHz sampling rate).
The EQ tool works on the Selected region in the Modify window, if there is one. Otherwise, it
works on the entire Modify window.
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2.5.7 The Gain Change Tool
The Gain Change tool increases or decreases the amplitude of the sound file or a portion of the
sound file in a range from -48 to +20 decibels.

Figure 2-27

Gain Change Dialog Box

The Gain Change Dialog Box is shown in Figure 2-27.
The Gain Change tool works on the Selected region in the Modify window, if there is one. If no
region is selected, it works on the entire Modify window.

2.5.8 The Normalize Tool
The Normalize tool automatically increases the volume of a sound to its maximum possible
level before clipping.
The Normalize tool works on the Selected region of the Modify window, if there is one. Otherwise, it works on the entire Modify window.

Figure 2-28 The Normalize Dialog Box

When you select the Normalize tool, the Normalize Dialog Box appears (Figure 2-28). At the
same time, if there is a Selected region, it will zoom in to fit the entire width of the Modify
window. The Normalize Dialog Box will tell you the amount of gain change that is needed, and
asks if you want to proceed.
When the Normalize function is completed, the amplitude (vertical size) of the Modify window
is re-scaled.
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2.5.9 DirectX™ Plug-ins
At the bottom of the Tools menu is a selection for DirectX™ Plug-ins (see Figure 2-29).

Figure 2-29

When you choose "DirectX" on the Tools menu, a list of DirectX™ plug-ins appears. These are
plug-ins that are not included in the Fast Edit™ software, but are third-party DirectX™ plug-ins
that you have installed on your computer. DirectX™ plug-ins are available from Waves, Cakewalk, Arboretum, Sonic Foundry, and many other software companies.
When you select a plug-in from the list, that plug-in will appear in the plug-in window on the
Fast Edit™ main screen (see Figure 2-30).

Figure 2-30

This plug-in will now be active. It will operate in real time whenever you are playing the top
window.
If you double-click on the plug-in name in the PlugIns window, it will bring up the plug-in
interface window, where you can change the parameters of the plug-in.
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You can add multiple plug-ins. They will all work in real time unless you run out of CPU
horsepower (see Figure 2-31).

Figure 2-31

You can also apply the plug-ins using off-line processing. That is, instead of applying the
plug-in while the soundfile is playing, you can apply the plug-in as a edit. The plug-in will then
modify the sound in the top window, and the modified sound can be saved.
To apply a plug-in off-line, right-click on the plug-in and choose "Apply to soundfile" if you
want it to work in the entire top window, or choose "Apply to selection" if you want to use it on
a selected area (see Figure 2-32) You can also apply ALL of the plug-ins in the plug-in window
to a soundfile or a selection..

Figure 2-32

After you apply the plug-in, Fast Edit™ will ask you if you want to remove the plug-in from the
Plug-ins window (see Figure 2-33). Most often you will choose "Yes". If you leave the plug-in
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open, then when you play back the top window, you will hear the plug-in applied twice, once
from off-line processing, and again in real-time during playback.

Figure 2-33

You can choose to not have this warning come up again. If you choose "Do not prompt again",
you have the options of 1) Automatically removing the plug-in after each off-line application,
or 2) Never removing the plug-in after off-line application.
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2.6 Markers
Markers are visual indicators you can use to remind yourself of the location of specific events in a
soundfile. Markers can also be used to create customized fade curves (see section 2.5.2, The Fade
Tool).

2.6.1 Creating and Modifying Markers
A marker is dropped at the location of the Edit Cursor when you hit the ‘m’ key. It appears on
the display as a small yellow bullet with one to four letters in its center. Markers dropped using
the “m” key are automatically named, in alphabetical order, starting with “A”. Up to 300
markers can be dropped in each window.
The ‘m’ key also drops markers during playback, and the markers can be dropped during
recording by clicking on the “drop marker” button in the Record Dialog Box. The markers are
displayed after the playback or recording has been completed.
If the ‘M’ key is typed, a marker is dropped at the Edit Cursor location with a name that you
specify; if the specified marker is already in use in the current display window, the option is
presented to either cancel the marker drop or move the marker from its previous location to the
Edit Cursor location.
Markers are moved within a sound file with "Ctrl-m". First, place the Edit Cursor over the
marker, then hit "Ctrl-m". Then move the Edit Cursor to the new location, and hit "Ctrl-m"
again. The marker will snap to the new location.
A marker at the Edit Cursor is deleted with the Delete Marker command on the Marker menu or
by typing "Ctrl-d". A specified marker is deleted with the Delete Named Marker command on
the Marker menu. Typing "Ctrl-e" deletes all of the markers in the current display window.
Typing "Ctrl-k" when the Edit Cursor is on a marker produces the View/Modify Marker dialog
box. It contains information that you can edit for the marker name, position, and amplitude (if
an amplitude has been assigned for a fade operation). A pair of buttons determine the fade type,
either linear or logarithmic, for the marker. The first two fields are for renaming the marker and
moving it to a new location; the second two are used for fade operations, which are discussed in
section 2.5.2, The Fade Tool.

2.6.2 Using Markers
The Edit Cursor is moved to the first marker to the right when you hit the "Tab" key. The Edit
Cursor is moved to the first marker to the left when you hit "Shift+Tab". (see section 2.1.3,
Moving the Edit Cursor). When a selection is copied, cut or deleted, the markers in the affected
selection are treated as part of the selection. When a region is pasted or replaced, duplicate
markers are replaced with new markers in the region being added.
Markers are saved in Editlists, independent from the sound files in which they are dropped.
Editlists are discussed in Section 2.2.8, “Editlists”.
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Markers are used as intermediate fade points in fade operations. The fade command is discussed
in section 2.5.2, The Fade Tool.
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2.7 Display
2.7.1 Zooming in the Waveform Display Area
When a sound file is opened, the entire sound file is displayed from beginning to end. The zoom
operations adjust the time scale along the bottom of the waveform display area, changing the
amount of the sound file that is being viewed and the level of detail in the displayed waveform.
Maximum zoom gives the greatest detail and the least amount of displayed sound.
Zooming in or out by a factor of two is accomplished by clicking on the ‘+’ and ‘-’ buttons on
the bottom of a sound display window. Zooming in or out by a factor of two can also be done
with the ‘+’ and ‘–’ keys on the keyboard, and by a factor of ten with the ‘~’ and ‘_’ keys.
The ‘z’ key toggles between Zoom Out Completely and a zoom level determined by the
Zoom-In Time, a preset time measured in seconds (see section 2.8.3, Sound File Display
Options). The ‘z’ key Zooms Out Completely if the waveform is Zoomed In to any level.
Zooming Out Completely with the ‘z’ key also recalculates the waveform display amplitude
scale (see section 2.7.3, Setting the Amplitude Scale of the Waveform Display Area).
If a region is Selected, typing the ‘v’ key zooms the waveform display so that the Selected
region fills nearly the entire window.

2.7.2 Scrolling the Waveform Display Area
Unless a file is completely zoomed out, portions of it are hidden because they are past the edge
of the waveform display area. These regions are viewed by any of three scrolling methods:
normal Edit Cursor movement, the scrolling keys, or the scroll bar.
Normal Edit Cursor movement will scroll the waveform display area in the direction of the
movement when the Edit Cursor approaches the edge of the display area.
The scroll bar at the bottom of a display window provides a convenient method of scrolling (see
Figure 2-34).

area to the left of the scroll button

area to the right of the scroll button
scroll button
Figure 2-34

By clicking in the area to the left of the scroll button, you cause the waveform to scroll once to
the left. By clicking in the area to the right of the scroll button, you cause the waveform to
scroll once to the right.
Also, the F5 and ‘l’ keys scroll toward the left, and F6 and ‘r’ keys scroll the waveform display
to the right.
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2.7.3 Setting the Amplitude Scale of the Waveform Display Area
When a soundfile is opened, it’s display is adjusted so that the highest peak reaches the edge of
the waveform display window. The relative level of the highest peak is displayed in the upper
right corner of the window.
Fast Edit™ lets you define the nominal clipping level in dB’s. Most DAT recorders define clipping level to be 0 dB. If you set the nominal clipping level of Fast Edit™ to be 0 dB, and a
newly opened soundfiles reads “-5dB” in the upper right window, it means that the highest peak
level in the soundfile is 5 dB below the clipping level.
Fast Edit™ lets you adjust the amplitude scale of the display window.
Hitting the “!” key stretches or shrinks the waveform vertically so that the highest peak of the
sound displayed in the window just barely reaches the edge of the window. The amplitude
display can now be used to read the relative level of the peak.
The display level can also be manually changed in steps of 3 dB. The “Ctrl-PgUp” key
increases the display scale by 3dB, and the “Ctrl-PgDn” key decreases the display scale by 3
dB.
The nominal clipping level is discussed in section 2.8.3, Sound File Display Options.

2.7.4 Show the Transport Bar
This options shows or hides the transport bar (see section 2.1.2, The Transport Bar and Control
Buttons)

2.7.5 Undo and the Edit History
Each time an editing action is performed or a tool is used, a record is made of the previous state
of the sound file, including zoom, scale, selection and markers. Fast Edit™ saves the ten most
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recent states of the Modify window’s sound file and lists them in the Edit History, as in Figure
2-35.

Figure 2-35

Edit History Dialog Box

The Edit History dialog box comes up when you hit the ‘h’ key. Each line of the edit history
consists of the time sequence of the edits performed. The time sequence is in order of operation,
with the last operation at the top, labeled “Current.” If an operation has been undone, it has the
label “undo.”
The edit history line that is highlighted is the one that reflects the current state of the sound file.
Usually this is the top line. You can change which line is highlighted by using the Up and Down
arrow keys on the keyboard, or by pointing at a line with the mouse and clicking the left button.
You can return the Modify window to the state that it was in during any of the last 10 edit operations. Just highlight that line of the Edit History, and click on the “Select” button. You can also
double-click the line of the Edit History.
The Edit History can be used to audition and compare different edits. It can also be used to go
back several steps, and start over; in effect, this gives you a multiple “undo” up to 10 deep.
Clicking on the Clear button removes all but the top line of the Edit History. When the edit
history is cleared, temporary soundfiles which are no longer needed are erased from the hard
disk. Clearing the edit history can sometimes free up some disk space when you run short
during editing.
The operation of the undo command is related to the edit history. Typing the Ctrl-z key
sequence or the F10 key undoes the last edit operation (which is the same as selecting the
second line of the edit history). If the most recent operation has been undone, or if an earlier line
of the edit history has been selected, an undo redoes all the operations up to and including the
most recent one.
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2.8 Options: Customizing Fast Edit™
To get to the Options dialog, go to the Display menu and select Options (see Figure 2-36).

Figure 2-36
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2.8.1 Sample Rate and Channel Settings Options
Three options are set in the Sample Rate/Channels dialog box, shown in Figure 2-37: the
sample rate, sample size and channel settings.

Figure 2-37

Sample Rate/Channels Dialog Box

These settings are used during recording and playback. If a “.wav” file is loaded into Fast
Edit™, and it’s parameters disagree with these settings, a dialog box will appear to ask if you
want Fast Edit™ to change the settings to match the new soundfile.

2.8.2 Record and Playback Options
Two options are set in the Record/Playback dialog box, shown in Figure 2-38: ,play audition
time, and scrub time.

Figure 2-38

Record/Playback Dialog Box

The Play Audition Time sets the number of milliseconds that are played during the operation of
an audition play (see section 2.4.1, Methods of Sound Playback).
The Scrub Time sets the amount of time displayed in the Waveform Display window during a
Scrub operation.
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2.8.3 Sound File Display Options
Two display options are set in the Display dialog box, shown in Figure 2-39: the clipping level
and zoom-in time.

Figure 2-39

Display Dialog Box

The Clipping Level is only a relative number that you assign as indicating the clipping level (in
other words, the highest digital level possible at clipping). Changing this number does not
change the gain of your audio card’s inputs or outputs. The display amplitudes shown on the
Fast Edit™ screen are calculated relative to the number you assign to Clipping Level. The
default value is 0 dB.
The zoom-in time is the length of sound file that is displayed when the ‘z’ key is typed to zoom
in the waveform display (see section 2.7.1, Zooming in the Waveform Display Area).

2.8.4 The Automatic Crossfade Option
Splices in audio editing can often result in an audible “click” at the splice point. The Automatic
Crossfade feature is designed to eliminate these “click”s.
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When the Automatic Crossfade feature is Enabled, a crossfade is automatically performed at
edit points that are likely to produce a “click”.

Figure 2-40

Automatic Crossfade Dialog Box

The parameters of the Automatic Crossfade can be customized (Figure 2-40). The default is a
10 millisecond linear crossfade. This is a good value for most editing work.

2.8.5 Default Directories Options
Three options are set in the Directories dialog box, shown in Figure 2-41:

Figure 2-41

Directories Dialog Box
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The Default Sound File Directory box is used to tell Fast Edit™ where you want your sound
files to be kept on the hard disk.
During an editing session, Fast Edit™ will generate a number of temporary files. You can
specify where these are to be kept using the Temporary File Directories. If the Primary
becomes full, Fast Edit™ uses the location you specify for the Secondary.
If any of these values are blank or invalid, the current directory is used. When a file operation is
used, the initial directory that is displayed is the Default Sound File Directory

2.8.6 Devices Options
A sample Devices dialog box is shown in Figure 2-42

Figure 2-42

Devices Dialog Box

This is where you assign the Windows™ device drivers for your soundcard, and also for your
MIDI source, if you have one.
Three devices may be selected from the Devices Options dialog. The Waveform Output device
is used for all playback operations. The Waveform Input device is used for all recording operations. The MIDI/SMPTE Input device is used when triggering a record operation from a MIDI
source.
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2.8.7 Memory Configuration Options
During the recording process, Fast Edit™ will be generating a “metasample” file.. This file is
used to make fast screen draws of the waveform display.

Figure 2-43

Memory Dialog Box

The Memory Options Dialog Box (Figure 2-43) allows you to reserve enough RAM for temporary storage of the metasample file during recording. The Time box tells you how much
recording time you have available with the amount of RAM selected. If you record more than
the specified amount of time, the metasample file will still be created after recording is
complete.
The dialog box also indicates the number of buffers that will be used for record and playback
sample data. Normally, 4 buffers are used for recording, and 4 buffers are used for playback.
If your system has audible skipping during playback, you may want to try increasing the
number of playback buffers.
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2.8.8 Time Display Options
In the lower right-hand corner of both waveform display windows is a time display (see Figure
2-44).

Time display

Figure 2-44
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Fast Edit™ gives you many options for time display. Figure 2-45 shows the Time Format
Options.

Figure 2-45

The time display options determine what the time display will show.
When "No display" is chosen, the time displays disappear.
When "Total File Time" is chosen, the total length of the sound is shown. This number does not
change as you zoom the window.
When "Window Time" is chosen, the amount of time of the sound displayed in the window is
chosen. This number changes as you zoom in and out.
When "Selection Time" is chosen, the display shows the amount of time in a Selected area.
This can be very useful if you need to Select an area of a specific amount of time.
When "Time at Cursor" is chosen, the time at the active Edit Cursor is shown.
The Time Format determines the time format for the time displays and the timeline along the
bottom of the waveform display windows.
"Real time" give time in Hours, Minutes, Seconds, and milliseconds.
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The "Frame" times give times in Hours, Minutes, Seconds, and Frames, in a video time format.
"Beats per Minute" gives time in beats, similar to the time format of a MIDI sequencer.
For some projects, it is useful to have the project start at some time other than zero. To change
the start time, click on the "Start Time" button. That will bring up a dialog that lets you select a
different start time (seeFigure 2-46).

Figure 2-46

Type in the times you want, or click on the up/down buttons. When you have the time you
want, click on the "Set" button. If you change your mind, and want to go back to the previous
start time, click on the "Reset" button. If you want to set all the times to "0", click on the "Zero"
button.

2.8.9 Plug-ins
Figure 2-47 shows the Plug-ins options menu.

Figure 2-47

In general, after you have applied a plug-in to a section of audio, you will want to remove it
from the plug-in window. If you don’t, the plug-in will also be heard in real time during playback, effectively giving you the plug-in twice.
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2.8.10 User Interface Options
Figure 2-48 shows the User Interface options dialog.

Figure 2-48

The "Cursor navigation stops playback" option, when selected, makes the playback stop
anytime you move the edit cursor. When it is not selected, you can move the edit cursor with
the arrow keys or with the scoll bar, and not affect the playback.
The "Auto scroll during playback" option, when selected, makes the waveform display keep
moving to the left in order to keep the play cursor on the screen. When it is not selected, the
waveform display will not change during playback, and the play cursor will go off the right
edge of the screen.
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2.9 Getting Help
2.9.1 Using the Help File
A table of contents is produced when the Contents command is selected from the Help menu, or
when the F1 key is typed in Fast Edit™ window.
For more information about using the help files, select the How to Use Help item from the Help
menu.
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2.10 Quick Reference - Fast Edit™ Commands
The following tables are a summary of commands found in the Fast Edit™ pulldown menus.
Each command is listed with any associated keyboard and mouse shortcuts, and a reference to the
place where the command is discussed.

File Menu

Command
New

Key

Description

Section

Ctrl+N

Clear the Modify window

2.2.3

Ctrl+O

Retrieve a soundfile from
the hard disk and display it
in the Read Only window

2.2.1

Shift+
C

Clear the Modify window or
the Read Only window,
whichever is active

2.2.3

Ctrl+S

Save the Modify window to
disk under the name from
the last Save As or Open for
Modify command

2.2.2

Convert the Modify window
to a soundfile and save it to
hard disk. It asks for a
filename.

2.2.2

Convert the selected portion
of the active window
soundfile to a soundfile and
save it to hard disk. It asks
for a filename.

2.2.2

Retrieve a soundfile from
the hard disk and display it
into the Modify window.
Can be used for destructive
editing

2.2.1

Open...

Close

Save

Save As...

Save Selection

Open for Modify...

Mouse
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File Menu (Continued)

Command
Save Editlist...

Key

Description

Section

Shift+S

Save the Modify window as
an Editlist

2.2.8

Shift+
L

Retrieve an Editlist from the
hard disk, and load it as a
sound into the Modify
window or the Read Only
window, whichever is active

2.2.8

Remove an Editlist and all
associated soundfiles from
the hard disk

2.2.8

Remove a soundfile and its
associated metasample file
from the hard disk

2.2.4

Record a soundfile to the
hard disk

2.2.5

Plays bottom window while
you record a new sound into
the top window

2.2.6

Exit Fast Edit™ and return
to Windows

2.2.9

Load Editlist...

Delete Editlist...

Delete Sound File...

Record...

Play and Record

Exit
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Alt+X

Mouse

Edit Menu

Command

Key

Mouse

Description

Section

Undo

Ctrl+
Z, F10

Remove the last edit
operation.

2.3.9

Redo

Ctrl+
Y, F11

Undo an undo (bring back
the last edit operation).

2.3.10

Ctrl+ Click “Copy”
C,F7 button

Copy a selected region into
the active Clipboard

2.3.3

Ctrl+
X

Delete the selected region
from the Modify window,
and make a copy into the
active Clipboard

2.3.3

Copy the active Clipboard
into the Modify window at
the Edit Cursor

2.3.3

w

Copy the Selected region in
the Read Only window into
the Clipboard, and paste it
into the Modify window at
the Edit Cursor. If no region
is Selected, the entire Read
Only window is copied

2.3.3

Shift+
D

Remove Selected region
from the Modify window

2.3.3

Replace a section of the
Modify window, starting at
the Edit Cursor, with the
segment in the active
Clipboard

2.3.3

Copy

Cut

Paste

Click “Paste”

Ctrl+ button
V,F8

Copy Paste

Delete

Replace
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Edit Menu (Continued)

Command

Key

Mouse

Description

Section

Shift+
V

Moves selected region to a
new location, without
changing overall length of
the soundfile

2.3.3

Ctrl+f

Records over a
predetermined section of a
soundfile

2.3.4

Ctrl+t

Replaces the Selected region
with silence

2.3.5

Separates the sound at the
Edit Cursor, and inserts a
segment of silence

2.3.6

Drop an anchor point at the
Edit Cursor so that any
movement of the Edit
Cursor will highlight a
region of the sound

2.3.2

Switch the active Edit
Cursor between the left and
right sides of a Selected
region

2.3.2

Select the entire sound in the
Modify or Read Only
window, whichever is active

2.3.2

Move

Punch In

Mute

Insert Silence...

Select

Click “S” button

F9, s

Toggle In/Out

i

Click on left
or right edge
of region

Select All

a
Top Window

Up Click in winArrow dow

Make the Modify window
the active window

2.3.1

Bottom Window

Down Click in winArrow dow

Make the Read Only
window the active window

2.3.1

82

Edit Menu (Continued)

Command

Key

Description

Section

F3

If the Modify window is
active, switch to the Read
Only window. If the Read
Only window is active,
switch to the Modify
window.

2.3.1

>

Make the Edit Cursor jump
to the right to the next splice
point

2.3.8

<

Make the Edit Cursor jump
to the left to the previous
splice point

2.3.8

Toggle Top/Bottom

Next Splice

Previous Splice

Mouse
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Play Menu

Command

Key

Mouse

Description

Section

Play entire window if there
is no Selected region, If
there is a Selected region,
plays only Selected region

2.4.1

Play entire window

2.4.1

Play entire sound, even if
window is zoomed-in and
not all of the sound is
displayed in the window

2.4.1

Click rt. mouse
button on Edit
Cursor

Playback starts at Edit
Cursor and plays to the end
of the window

2.4.1

Click on edge of
Selected region

If a region is Selected, plays
a short section from left
edge of Selected region, or a
short section leading up to
the right edge of Selected
region. If no Selected
region, plays short section
from before Edit Cursor till
after Edit Cursor (keyboard
only)

2.4.1

Play

F4, p
Play Window

Click rt. mouse

Shift+P button

Play File

f
Play from Cursor

Ctrl+P

Audition Play

Alt+P

Play Clipboard

Click clipboard
btn. with rt.
mouse button

Scrub

F2
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Play contents of clipboard
Plays the waveform as you
drag the cursor with the
right mouse button

2.4.1

2.4.3

Play Menu (Continued)

Command

Key

Mouse

Pause

Space
Stop

Click rt. mouse

Enter button during
playback

Loop Playback

Play the
Selected area
over and over

Description

Section

When playing, hitting the
Space bar pauses recording.
Hitting the Space bar a
second time resumes play

2.4.1

When playing, hitting the
Enter key stops playback

2.4.1

Enables playback looping
for entire window or
selected region

2.4.2
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Tools Menu

Command
Mix...

Fade...

Manual Crossfade...

Reverse

Gearshift...

EQ...

Gain Change...
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Key

Mouse

Description

Section

Mix the sound in the active
Clipboard with the sound in the
Modify window, starting at the
location of the Edit Cursor

2.5.1

Perform fade-ups and fade-downs
using Selected regions, or
customized fades using markers

2.5.2

Overlap sounds at the Edit Cursor,
with a fade-out of the first sound,
and a fade-in of the second sound

2.5.3

Reverse the waveform in the
Selected region, so that sounds in
this region will be played
backwards. If no region is Selected,
works on entire window

2.5.4

Same effect as speeding-up or
slowing-down an analog tape
(changes pitch and duration). Works
on Selected region, or if no region is
Selected, works on entire window

2.5.5

Adjustable bass and treble shelving.
Works on Selected region, or if no
region is Selected, works on entire
window

2.5.6

Change the gain by specified
amount. Works on Selected region,
or if no region is Selected, works on
entire window

2.5.7

Tools Menu (Continued)

Command
Normalize...

DirectX

Key

Mouse

Description

Section

Increase the gain to the maximum
level without clipping. Works on
Selected region, or if no region is
Selected, works on entire window

2.5.8

Drop a DirectX™ plug-in onto the
Modify window

2.5.9
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Marker Menu

Command

Key

Description

Section

m

Drop automatically-named
markers starting with marker
“A”. Markers are dropped at
the Edit Cursor, except
playback, when markers are
dropped “on the fly”

2.6.1

Shift+M

Same as Drop Marker,
except that you can give
markers custom names

2.6.1

Tab

Moves Edit Cursor to the
right to the nearest marker

2.6.2

Shift+Ta
b

Moves Edit Cursor to the
left to the nearest marker

2.6.2

Ctrl+M

Grabs marker at the Edit
Cursor, to be moved to a
new location

2.6.1

Ctrl+D

Deletes the marker at the
Edit Cursor

2.6.1

Drop Marker

Drop Named Marker...

Next

Previous

Move

Delete

Delete Selected Markers
Delete All Markers

Mouse

Deletes all markers inside of
a Selected area
Deletes every marker in the
active window

2.6.1

Delete Named
Marker...

Let’s you enter the name of
the marker to be deleted

2.6.1

View/Modify Marker...

Change the name. position,
fade amplitude or fade type
of the marker at the Edit
Cursor

2.6.1

Ctrl+E

Ctrl+K
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Display Menu

Command

Key

Mouse

Zoom In Completely

Zoom Out Completely
Toggle Zoom In/Out

z
Zoom In by 2

+

Click “+”
button

Zoom In by 10

~
Zoom Out by 2

–

Click “–”
button

Zoom Out by 10

_
Lock waveforms

=

Click on
Lock
Waveform
button

Description

Section

Stretch the waveform display
at the Edit Cursor to the
maximum level of detail

2.7.1

Display entire sound in
window

2.7.1

Switch between zoom-in to a
preset level, and zoom-out
completely

2.7.1

Horizontally stretch the
waveform at the cursor by a
factor of 2, to see the
waveform in better detail

2.7.1

Horizontally stretch the
waveform at the cursor by a
factor of 10, to see the
waveform in better detail

2.7.1

Horizontally compress the
waveform by a factor of 2, to
see more of the sound in the
window

2.7.1

Horizontally compress the
waveform by a factor of 10, to
see more of the sound in the
window

2.7.1

Makes top and bottom
windows have identical
timescales; makes edit cursor
work across both windows

2.1.4
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Display Menu (Continued)

Command

Key

Mouse

Description

Section

Stretch the Selected region to
nearly the full width of the
window

2.7.1

Click in
scroll bar

When zoomed in, slides the
waveform to the left, so you
can see sounds later in the
soundfile

2.7.2

Click in
scroll bar

When zoomed in, slides the
waveform to the right, so you
can see sounds earlier in the
soundfile

2.7.2

Ctrl+
PgUp

Increases the amplitude scale
in the active window by +3
dB

2.7.3

Ctrl+
PgDn

Decreases the amplitude scale
in the active window by 3 dB

2.7.3

!

Adjust the amplitude scale of
the active window to the peak
amplitude of the sound
displayed in the window

2.7.3

Show or Hide the Transport
Bar betweent the Top and
Bottom windows

2.7.4

Displays the Edit History list,
which is a list of up to the last
10 edits performed. The Edit
History list, in effect, allows
you to undo up to 10 edit
operations

2.7.5

View Selection

v
Scroll Left

F5, l
Scroll Right

F6, r
Scale +3dB

Scale -3dB

Scale to Window

Show Transport Bar

Edit History...

h
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Options Menu

Command

Key

Mouse

Sample Rate/Channels...

Record/Playback...

Display...

Automatic Crossfade...

Click on
“X’ control button

Directories...

Devices...

Memory...

Time Display...

t

Description

Section

Lets you set sample rate, stereo/
mono, and bit depth for
recording soundfiles

2.8.1

Lets you set Play Audition
Time and Scrub Time

2.8.2

Lets you set the nominal
clipping level, and the zoom-in
time

2.8.3

Enable/disable automatic
crossfades, and set crossfade
parameters. Automatic
crossfades are used to
automatically remove clicks
from edits

2.8.4

Tells Fast Edit™ which drive
and directory are to be used to
store soundfiles

2.8.5

Lets you assign the Windows
drivers for your sound card and
your MIDI/SMPTE card

2.8.6

Lets you allocate the amount of
RAM to be reserved for
metasample files, plus
playback, and recording buffers

2.8.7

Lets you choose which time to
display, and the format

2.8.8
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Options Menu (Continued)

Command
Plug-ins

User Interface Options
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Key

Mouse

Description

Section

Lets you decided if a
DirectX™ plug-in will remain
on the list after off-line
processing

2.8.9

Lets you decide if playback
will stop when the edit cursor is
moved; also whether waveform 2.8.10
display will scroll during
playback

Help Menu

Command
Contents

Key
F1

Mouse

Description

Section

Provides a list of topics on
which help is available

2.9.1

Search

Lets you search for a particular
topic

How to Use Help

Instructions on how to use Help

About Fast Edit™...

Give the Version Number of the
software

2.9.1
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3 Shortcuts
This is a listing of some of the mouse and keyboard shortcuts which can significantly speed up your
editing work.

3.1 Grabbing and Placing the Edit Cursor.
Regardless of where the Edit Cursor is placed in a Waveform Dirplay Window, you can snap it to
any desired location by pointing to where you want it, and double-clicking the left mouse button.

3.2 Turning on the Select feature.
You can turn on the select feature using only the mouse. To turn on the Select feature, hold down
the left mouse button, and while you hold it down, click the right mouse button.

3.3 Turning off the Select feature.
You can turn off the Select feature by double-clicking the left mouse button. (This also causes the
Edit Cursor to snap to the mouse pointer. See section 3.1, Grabbing and Placing the Edit Cursor.)

3.4 Quick Select
If you have the Edit Cursor set to one side of a region you want to Select, you can do a quick
selection by pointing the mouse to the other side of the region you want to Select, then hold down
the left mouse button while you click the right mouse button. The region between the Edit Cursor
and the mouse pointer will be Selected (highlighted).

3.5 Copy-and-Paste from the Read Only window to the Modify
window.
Use the “w” key on the computer keyboard for a fast copy-and-paste from the bottom window to
the top window. This will take a copy of the Selected region in the bottom window (or the entire
bottom window if there is no selected region) and paste it into the top window at the location of
the Edit Cursor. It will also place a copy of this sound into the Clipboard.
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4 Catalog Editor - functional reference
4.1 The Catalog main screen
Figure 4-1 shows a sample Sound Catalog screen.

Figure 4-1 A sample Sound Catalog screen.

The Catalog editor lets you build screens of sounds you can play quickly and easily. Just point
and click the right mouse button.
The Catalog is useful for playing sound effects on-air or for theatre, or for “flying-in” sound
effects during mix-down of a recording.
You can make up your own Sound Catalog screens quickly and easily.
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4.2 Opening, Closing, and Saving Catalog Files
4.2.1 Opening a Catalog
Figure 4-2 shows the Open Catalog File Dialog Box.

Figure 4-2 The Open Catalog File Dialog Box

The dialog in Figure 2-3 is displayed when you select the Open option under the Files menu. To
open up an existing Catalog and display it on the screen, just select the name of the Catalog
from the list. Catalog names are saved on the disk with a filename extension of “.cat”.
If you want to retrieve a Catalog from a different drive, click on the down-arrow under
“Drives:” and select the drive you want. To select a different directory, click on the directory
name under “Directories:”.

4.2.2 Closing a Catalog
To close a catalog, select the New or Close options from the File menu. If you have made
changes to the previous Catalog, the Catalog Editor prompts you to ask if you want to save the
changes.
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4.2.3 Saving a Catalog
To save a new Catalog, select the Save As command from the Files menu. The Save As Dialog
Box will appear (Figure 4-3).

Figure 4-3 The Save As Dialog Box

Type in the name of your new catalog. The Save As will automatically add the extension “.cat”
to the filename.
If you modified an existing Catalog, you can save the changes by selecting the Save command
under the Files menu.
If you want to save a copy of an existing Catalog under a different name, or on another disk
drive, or in another directory, select the Save As command in the Files menu.
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4.2.4 Deleting a Sound Catalog
The Delete menu item lets you delete a Sound Catalog from your hard disk. Selecting Delete
brings up the Delete Catalog Dialog Box (Figure 4-4).

Figure 4-4 The Delete Catalog Dialog Box

4.2.5 Exiting the Sound Catalog Editor
To exit the Sound Catalog Editor, select the Exit command in the Files menu.
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4.3 Adding, Modifying, and Deleting Sounds
4.3.1 Adding Sounds
To add a sound to the end of a Catalog, select the Add command from the Edit menu. This will
bring up the Catalog Item Dialog Box (Figure 4-5). You can type in the name of the soundfile to
be added to the catalog, or you can hit the “browse” buttton.

Figure 4-5 The Catalog Item Dialog Box

Once you’ve hit the “browse” button, a list of available soundfiles comes up. You can select one
of these soundfiles and click on “OK”. The name of the selected soundfile will come up in the
“Associated Sound File” box.
The abbreviated name of the soundfile will also appear in the “Display String“ box. This is the
name that will appear on the catalog screen for this sound. If you want to give it a name that’s
different from the soundfile name, click inside the box “Display String“ box, and type in the
new name.
Then click on “OK”. Your new Catalog Item will appear on the screen.
If play is enabled (see section 4.5), you can now point to the new Catalog Item and click the
right mouse button to play it.
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The Insert command in the Edit menu works just like the Add command, except that the new
Catalog Item is placed before the currently hightlighted Catalog Item.

4.3.2 Modifying Sounds
The Modify command brings up the Catalog Item Dialog Box for the highlighted Catalog Item
on the screen. You can change the Associated Soundfile or the Display String of the Catalog
Item.
You can highlight a Catalog Item by pointing to it and clicking the left mouse button. You can
also use the arrow keys to select a Catalog Item.

4.3.3 Deleting Sounds
The Delete command under the Edit menu removes the highlighted Catalog Item from the
Catalog screen.

4.3.4 MIDI Trigger
The Add, Insert, and Modify commands also let you assign a MIDI trigger to catalog items. You
can type in a MIDI note (1 to 127) and channel number (1-16). Then, if the proper devices are
installed (see section 4.6) and the play is enabled (see section 4.5.1), the Catalog will play the
Catalog Item each time it’s MIDI note and channel number are received.
The “Listen” button on the Catalog Item Dialog Box makes it easy to assign MIDI notes. Just
click on the Listen button, and then feed the Catalog the desired MIDI note, such as by hitting
that note on your MIDI keyboard. The note and channel number for that key will automatically
appear in the Catalog Item Dialog Box. When you have the note assignment that you want,
click on the OK button to exit the Catalog Item Dialog Box.

4.3.5 Using the MIDItasker driver
When you are multitasking The Catalog Editor with your Windows MIDI sequencer program,
you should use the MIDItasker driver.
To use the MIDItasker, follow this procedure:
1) Select the setup button on the Windows Control Panel Drivers program for the MIDItasker
driver. Select the MPU401 driver (or other Windows driver that comes with your MIDI card) as
the MIDI output device for the MIDItasker driver. You must also select the midi channel to use
to trigger Catalog items.
2) In the Catalog Editor, select the MIDItasker driver as the MIDI input device.
3) In your MIDI sequencer program, select the MIDItasker driver as your MIDI output device.
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The MIDItasker driver will allow your sequencer program to function normally with your MIDI
card, but will also allow The Catalog Editor to listen to the MIDI traffic, so that it can fire off
soundfiles from a track on your MIDI sequencer.

4.4 Display
4.4.1 Resize Items
You can adjust the size of the Catalog Item boxes that are displayed on the screen. Just select
Resize Items in the Display menu. Then use the arrow keys to adjust the size of the boxes.
When you are done, disable the Resize Items in the Display menu. To save your resized
Catalog, use the Save or Save As command.

4.5 Play
4.5.1 Play Enable
To turn on the playback feature of the Catalog, select the “Enable” command in the Play menu.
This will turn on the Play Enable, and will put a check mark next to Enable on the menu.
Selecting the Enable tells the Catalog to take ownership of the driver for the audio card. While
Catalog Play is Enabled, no other program will be able to use the audio card.
The next time you select Enable, the Play Enable will be turned off. The check mark will be
removed from Enable in the menu, and the driver for the audio card will be available for other
programs to use.

4.5.2 Playing Catalog Items
Catalog Items can be played by pointing to them with the mouse and clicking the right mouse
button. The Catalog Item will be highlighted, and the playback will start immediately. If another
Catalog Item was playing and the Queue was not enabled (see section 4.5.3), the currently
playing Catalog Item will be stopped, and the newly selected Catalog Item will start playing.
If a Catalog Item is playing, the playback can be stopped by hitting the Shift+s key. Playback
can be paused by hitting the Space bar. Hitting the Space Bar again will resume the playback
where it left off.
A highlighted Catalog Item can be played from the keyboard by hitting the Enter key. Different
Catalog Items can be highlighted by using the arrow keys or the left mouse button.
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4.5.3 Playback Queue
When you select the Queue command in the Play menu, the Queue is enabled, and a check mark
is placed next to Queue on the menu.
If a new Catalog Item is selected for play when another is currently playing, the currently
playing item will complete playback before the new Catalog Item begins playing. Also, if
multiple Catalog Items are selected for play, the Catalog Editor will remember all of the selections, and play them in order.
The next time you select Queue on the Play menu, the Queue feature will be disabled, and the
checkmark will be removed.

4.5.4 MIDI Stop
When you select Ignore MIDI Stop in the Play menu, a check mark will be placed next to it, and
any Catalog Item that is triggered by a MIDI note will play until it is finished, unless interrupted
by another Catalog Item, or by a computer keyboard Pause or Stop.
When Ignore MIDI Stop is disabled, a MIDI “note-off” command will stop the playback of a
Catalog Item that was triggered by a MIDI “note-on” command.

4.6 Options
4.6.1 Sample Rate/Channels
In normal use, the Catalog will use “.wav” soundfiles. When “.wav” files are used, this menu
item is ignored, and the Catalog sets the sample rate and channels based on the information in
the “.wav” files.
The Catalog is also capable of playing Red Book Audio files, and when they are used, the
sample rate and channels are set by this menu item.

4.6.2 Devices
The Devices menu allows you to assign the driver for your audio card, and the driver for your
MIDI card, if you are using one.
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0.1 Quick Reference - Catalog Commands
File Menu

Command

Key

Description

Section

Ctrl+
N

Closes the
currently
displayed sound
catalog

4.2.2

Ctrl+
O

Opens an
existing sound
catalog

4.2.1

Shift+
C

Closes the
currently
displayed sound
catalog if it’s a
named catalog

4.2.2

Crtl+S

Saves revisions
to the current
catalog if it is a
named catalog
already existing
on the hard drive

4.2.3

Stores catalog
onto the hard
drive under the
name given

4.2.3

Deletes a Sound
Catalog from the
hard drive

4.2.4

Exit the Catalog
Editor

4.2.5

New

Open...

Close

Save

Save As...

Delete

Exit

Alt+X

Mouse
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Edit Menu

Command
Add

Key

Description

Section

Ctrl+
A

Add a sound to
the Catalog

4.3.1

Ctrl+I

Add a sound to
the Catalog
before the item
highlighted on
the screen

4.3.1

Ctrl+
V

Change the
soundfile,
display name, or
trigger of the
item highlighted
on the screen

4.3.2

Ctrl+
D

Delete the item
highlighted on
the screen

4.3.3

Insert

View/Modify

Delete
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Mouse

Display Menu

Command

Key

Resize Items

Cntl+
R

Mouse

Description

Section

Activates the
arrow keys to be
used to change
vertical and
horizontal size of
items on the
Catalog screen

4.4.1
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Play Menu

Command

Key

Mouse

Description

Section

Cntl+
E

Enable must be
selected for the
Catalog to use
the audio card
driver to play
sounds

4.5.1

Space

Momentarily
stops playback of
item, can also
restart playback

4.5.2

Shift
+S

Stops playback
of item

4.5.2

The Enter key
plays the
highlighted item
on the screen.

4.5.2

Enable

Pause

Stop

Play Item

Enter
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Click
on item
with
right
mouse
button

Play Menu (Continued)

Command

Key

Queue

Cntl+
Q

Ignore MIDI Stop

Mouse

Description

Section

If items are
selected for play
while an item is
currently
playing, the
Catalog will
remember the
selection and
play them in
order, with no
time gap
inbetween

4.5.3

When items are
triggered by
MIDI, this
determines
whether a MIDI
stop code will
stop playback or
not

4.5.4
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Options Menu

Command
Sample Rate/
Channels

Devices
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Key

Mouse

Description

Section

Brings up dialog
to set sample
rate, stereo or
mono, and 8- or
16-bits.

4.6.1

Brings up dialog
to assign
waveform output
device and MIDI
input device.

4.6.2

5 Playlist editor - functional reference
5.1 The Playlist editor main screen
Figure 5-1shows the main screen of the Playlist editor.

Figure 5-1 The main screen of the Playlist Editor.

The main screen of the Playlist Editor has 3 major sections.
The upper left-hand corner of the screen shows the Playlist. This is the list of sounds that will be
played in order. For each sound on the list, the Start Time, End Time, and Duration are given.
In the upper right-hand corner is the Region Library. This is the list of sounds that are available to
place onto the Playlist.
At the bottom of the screen is the Waveform Display. The Waveform display is used to mark the
sections of Soundfiles or Editlists that will make up a region.
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5.1.1 Making regions
Before a Playlist can be made, a Region Library must be created. This is the list of sounds that
can be put on the Playlist.
The sounds in the Region Library can be either a complete Soundfile or Editlist, or a part of a
Soundfile or Editlist. Complete Soundfiles and Editlists can be added to the Region Library by
selecting the Add Soundfiles/Editlists command from the Region menu.
Parts of Soundfiles or Editlists can be added to the Region Library. First you open a Soundfile
or Editlist into the Waveform Display, by using the Open Soundfile/Editlist in the Waveform
menu. Then you select the portion of the sound that you want to save, using the Select feature of
the Waveform Display window (see section 2.3.2, Making Selections in the Waveform Display
Area). Then you name this portion of sound and place it onto the Region Library, using the
Create/Modify command in the Region menu.

5.1.2 Making a Playlist
Once you have a Region Library of sounds, these sounds can be placed onto the Playlist.
To place sounds onto the Playlist, first highlight the sound on the Region Library that you want
to place on the Playlist. Then click on the “Add” button in the Playlist window. Your highlighted item will be added to the bottom of the Playlist.
If you want to add a sound in the middle of the Playlist, click on the Playlist item immediately
after where you want your new sound to be. Then click on the “Insert” button. The highlighted
sound in the Region Library will be inserted immediately above the highlighted Playlist item.
If you want to remove a Playlist item, highlight that item and then click on the “Delete” button.
You can also replace a Playlist item with a new sound. Highlight the new sound that you want in
the Region Library, and highlight the Playlist sound that you want to replace. Then click on the
“Replace” button.

5.1.3 Playing your Playlist
The Playlist can play in one of three modes:
1) Play (play list sequentially), or
2) Play One (play a single line), or
3) Chase (SMPTE triggered).
Sequential play can be started by clicking on the “Play” button under the Playlist. The Playlist
will start playing from the highlighted line, or if there is no line highlighted, it will start playing
from the top of the Playlist. As each item plays, it will be highlighted. The time counter, in the
lower right-hand corner of the Playlist screen, will be counting to indicate the playback time
relative to the Start and Stop times listed in the Playlist. Play will continue until the entire Play-
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list is played, then playback will stop. If you hit the Play button again, it will start playing from
the top of the list.
If you highlight a line, and then hit the Play button, playback will start from that line. If you hit
the “Stop” button during play, the play will stop. The “Fwd” and “Rew” buttons can
fast-forward and rewind the time counter to start playback of the Playlist at any time.
The start time of each event can be manually adjusted to allow a gap of time from the end of the
previous sound on the Playlist. If you double-click on the Playlist item you want to change, a
“Change Time” Dialog Box will appear, to let you adjust the start time. If you adjust it so that
there is a time gap from the end of the previous sound to the start of the selected sound, the start
time for that sound will be tagged with a “*”.
Single-line play can be started by clicking on the “Play 1” button under the Playlist. After each
playlist is played, the next playlist is highlighted but the playback is paused until the “Play 1”
button is clicked.
SMPTE triggered play can be activated by choosing the SMPTE function in the Options menu.
When SMPTE is selected, all items in the Playlist can be given specific SMPTE start times.
Then, you start SMPTE playback by clicking on the “Chase” button. When SMPTE time codes
are received by your SMPTE timecode reader card, the timecodes received will be shown in the
time display in the lower right-hand corner of the Playlist window. When an incoming timecode
matches the number assigned as the Start Time for a sound, that sound will begin playing.
The Playlist does a Chase-Trigger, which is to say that the timecode stream can start at any
randon time, and the Playlist will know which is the next sound on the Playlist to be triggered.
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5.2 Opening, Closing, Saving, and Deleting Playlists
5.2.1 Opening a Playlist
When you select the Open command from the Files menu, the Open Playlist Dialog Box comes
up (Figure 5-2).

Figure 5-2 The Open Playlist Dialog Box

This dialog presents you with a list of Playlist files in the currently selected directory. Playlists
are stored to the hard disk with the filename extension “.pla”. When you select a Playlist file,
the Playlist will come up in the Playlist window.

5.2.2 Closing a Playlist
The New command in the Files menu will close the current Playlist, and clear the Playlist
screen. If you have made changes to the Playlist, the Playlist Editor will prompt you asking if
you want to save the changes before closing.

5.2.3 Saving a Playlist
If you want to save a new Playlist, you will use the Save As command in the Files menu. The
Playlist Editor will prompt you for a name for your new Playlist. It will automatically add the
“.pla” filename extension to your name.
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If you want to save an existing Playlist after making modifications, you will use the Save
command in the Files menu. The Save command will save the revised Playlist under the current
filename.

5.2.4 Deleting a Playlist
To delete a Playlist, select the Delete command from the Files menu. A dialog box will ask you
if you want to delete the currently displayed Playlist. If you answer “OK”, it will remove the
Playlist from the hard disk, and clear the Playlist window.

5.2.5 Exiting the Playlist Editor
To exit the Playlist Editor, select the Exit command from the Files menu.

5.3 Edit
The commands in the Edit menu are used to edit the items in the Playlist window only.

5.3.1 Adding a Sound to the Playlist
To add a sound to the bottom of your Playlist, first select the sound to be added by highlighting
it on the Region Library. Then select Add from the Edit menu, or click on the Add button in the
Playlist window. The highlighted sound from the Region Library will be copied to the bottom of
the Playlist.

5.3.2 Inserting a Sound into the Playlist
The Insert command lets you add a sound to your playlist anywhere other than the bottom. To
use insert, first highlight the sound on the playlist where you want to insert another sound. Then
highlight the desired new sound from the Region Library. Next, select the Insert command from
the Edit menu, or click on the Insert button in the Playlist window. All of the sounds on the
Playlist from the highlighted sound to the end will be moved down one line, and the new sound
will be inserted in the line that is opened up.

5.3.3 Replacing a Sound on the Playlist
Any sound on the Playlist can be replaced by a sound from the Region Library. Just highlight
the sound to be replaced on the Playlist, highlight the new sound to be used from the Region
Library, and select the Replace command from the Edit menu, or click on the Replace button in
the Playlist window.

5.3.4 Deleting a Sound on the Playlist
To delete a sound from the Playlist, highlight that sound, and then select the Delete command
from the Edit menu, or click on the Delete button in the Playlist window.
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5.3.5 Changing the Start Time of a Sound on the Playlist
The start time of a sound on the Playlist Editor can be adjusted using the Start Time command.
In a sequential (or “real time”) Playlist, the Start times are automatically calculated each time an
item is added to the Playlist. The sounds on the Playlist play one at a time, with no time gap
between consecutive sounds. For a sequential playlist, the Change Time command can be used
to add a gap of time between a sound and the previous sound.
For a SMPTE Playlist, the Change time command can be used to set or adjust the SMPTE time
that will fire the sounds on the Playlist.
To change the Start times, highlight the sound you want to change on the Playlist, and then
select the Start Time command from the Edit menu, or double click on the sound. A Change
Time Dialog Box will appear (Figure 3-3) in which you can change the Start time by either
typing in new values, or by clicking on the up/down buttons by each number. After you have
selected the Start time that you want, set it into the Playlist by clicking on the Set button, then
the Close button.

Figure 0-1 The Change Time Dialog Box
The Change Time Dialog Box can be used for marking SMPTE timecodes “on-the-fly”. To do
this, click on the Live button. The numbers in the box will now reflect the time display in the
bottom right-hand corner of the Playlist window. Then start the SMPTE time source (such as a
video tape). When you pass times that you want a sound to be fired, click on the Mark button in
the Dialog Box. Each time that you click on the Mark button, a blank line will be added to the
Playlist, with the timecode that was displayed at the moment you hit the Mark button. You can
later use the Replace function to assign sounds to these times on the Playlist.
The Reset button in the Change Time Dialog box changes the time of a sound so that it plays
immediately after the end of the previous sound.
Sounds in the Playlist will not play properly if the sounds are allowed to overlap in time.
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5.4 The Region Library
The Region Library is the collection of sounds that are available for use on your Playlists. A
Region can be an entire soundfile (or Editlist), or it can be any part of a soundfile (or Editlist).

5.4.1 Adding and Modifying Regions
To add an entire soundfile or Editlist to your Region Library, select the Add Soundfiles/Editlists
command in the Region menu. An Open Dialog Box will appear (Figure 5-3).

Figure 5-3 The Open Dialog Box for Adding Soundfiles and Editlists to the Region Library

The dialog box will list the Soundfiles and Editlists in the selected directory. Click on the
desired Soundfile or Editlist, and then click on OK. The sound will now be in the Region
Library, and under the same name (but without the filename extension).
More than one file may be selected in the dialog by dragging the mouse across the selections, or
holding the Shift key while clicking on the file name.
To add a part of a Soundfile or Editlist, you must first open the Soundfile or Editlist into the
Waveform Display at the bottom of the screen. Do this by using the Open Soundfile/Editlist
command in the Waveform menu (see section 5.5.1, Opening a Soundfile for Display). Once the
sound is displayed in the Waveform Display, you can select a portion of the sound for the
Region Library. Just do a Selection as you would do it in FastEdddie (see section 2.3.2, Making
Selections in the Waveform Display Area). When you are satisfied that you have Selected the
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right region, select the Create/Modify command in the Region menu. The Create/Modify
Region Dialog Box will appear (Figure 5-4).

Figure 5-4 The Create/Modify Region Dialog Box

Type in the name you want to give this region, then click on “OK”. A new region will now
appear in your Region library, with the name you selected.
At any time, you can view the Soundfile and Selection of any region in your region library by
highlighting that item on the Region Library list, then selecting the View command from the
Region menu. The Waveform Display will now show you the entire Soundfile (or Editlist),
along with showing the part you Selected. You can use this to edit your region by changing your
Selected portion of the Soundfile, then saving the changed Selection back to the Region Library
by using the Create/Modify command in the Region menu.

5.4.2 Deleting Regions
Regions can be deleted from your Region Library by highlighting the Region you want to get
rid of, then selecting the Delete command from the Region menu.
You can delete all the Regions from your Region Library by selecting the Clear Library
command from the Region menu.

5.4.3 Changing Region Libraries
You can have any number of Region Libraries. Each library is stored on the hard disk with the
name you specify, plus the filename extension “.rlb”. Typically, you will make different Region
Libraries for different editing projects.
To change the displayed Region Library, select the Change Library command from the Region
menu.
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5.5 Waveform Display
5.5.1 Opening a Soundfile for Display
Before a Region can be created out of part of a Soundfile or Editlist, the Soundfile or Editlist
must be displayed in the Waveform Display so that you may Select the part of the sound you
want for your Region Library.
To display a Soundfile or Editlist, select the Open Soundfile/Editlist command from the Waveform menu. The Dialog box will give you a list of the available Soundfiles and Editlists in the
specified directory. Select one of the Soundfiles or Editlists, and click on “OK”. The sound will
be displayed in the Waveform Display window.

5.6 Options
5.6.1 Sample Rate/Channels
When using the Playlist Editor, all Soundfiles used should be the same format (that is, the same
sample rate, stereo or mono, and 8-or 16- bits).
The file format must be specified. Just select the Sample Rate/Channels command from the
option menu, and select the options for the file format you will be using.

5.6.2 Directories
This option is used to set the default Soundfile directories that will be used by the Playlist
Editor.

5.6.3 SMPTE
This option determines whether the Playlist will work in sequential (real-time) mode or in
SMPTE trigger mode. When the Playlist is run in sequential mode, the items on the Playlist start
playback when the Play button is clicked, and continues to play until the end of the list. In
SMPTE mode, each item on the list will play whenever the incoming SMPTE timecode matches
the designated SMPTE Start Time, regardless of what has played previously.
Options are given for different frame rates for SMPTE.
For SMPTE triggering to work, the “Enable SMPTE trigger” must be selected.
When the real time mode is selected, the last two digits of the displayed times are in 1/100’s of
a second. When SMPTE trigger mode is selected, the last two digits are in frames.
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5.6.4 Devices
This option is used to specify the driver for the audio card that is used.
This option is also used to specify the driver for the SMPTE timecode reader card, if one is
used. The software reqires a MusicQuest MQX-16S or MQX-32M.

5.7 Quick Reference - Playlist Commands
File Menu

Command

Key

Description

Section

Ctrl+
N

Closes the
currently
displayed
Playlist

5.2.2

Ctrl+
O

Opens an
existing Playlist

5.2.1

Ctrl+S

Saves revisions
to the current
Playlist if it is a
named Playlist
already existing
on the hard drive

5.2.3

Stores Playlist
onto the hard
drive under the
name given

5.2.3

Deletes a Playlist
from the hard
disk

5.2.4

Exit the Playlist
Editor

5.2.5

New

Open...

Save

Save As...

Delete

Exit
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Alt+X

Mouse

Edit Menu

Command

Key

Mouse

Description

Section

Alt+A

Click
on Add
button

Add a sound to
the Playlist from
the Region
Library

5.3.1

Alt+I

Click
on
Insert
button

Add a sound to
the Playlist
before the item
highlighted on
the screen

5.3.2

Click
on
Replace
button

Replaces the
highlighted
Playlist item
with the
highlighted
Region Library
item

5.3.3

Click
on
Delete
button

Delete the item
highlighted on
the Playlist

5.3.4

Double
click on
sound,
or click
on the
current
time
display

Bring up Start
Time dialog box
to enter or adjust
the start time of a
sound on the
Playlist

5.3.5

Add

Insert

Replace

Alt+E

Delete

Alt+D
Start Time
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Region Menu

Command

Key

Mouse

Create/Modify

Cntl+
C
View

double
click on
Region
Library
item

Delete

Add Soundfiles/
Editlists

Change Library

Clear Library
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Cntl+
L

Description

Section

Add new regions
to the Regions
list, or modify
existing Regions

5.4.1

Display the
Soundfile or
Editlist that the
highlighted
Region comes
from

5.4.1

Delete the
highlighted
Region from the
Region Library

5.4.2

Add entire
Soundfiles or
Editlists to the
Region Library

5.4.1

Switch to a
different Region
list

5.4.3

Remove all
Regions from the
Region Library

5.4.2

Waveform Menu

Command
Open Soundfile/
Editlist

Key

Mouse

Description

Section

Opens a
Soundfile or
Editlist into the
Waveform
Display

5.5.1
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Options Menu

Command
Sample Rate/
Channels

Directories..

SMPTE..

Devices..
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Key

Mouse

Description

Section

For playing
“.snd” files, sets
the Sample Rate,
Stereo/Mono,
and 8-/16-bits

5.6.1

Sets default
directory for
Playlists

5.6.2

Selects between
real-time
sequential
playlist and
SMPTE-triggere
d Playlist. Also
sets format for
SMPTE.

5.6.3

Loads device
drivers for audio
card and SMPTE
reader card

5.6.4

A
active window 33, 46
amplitude scale 32, 66
anchor 46
audition play 51
audition time 48, 69
automatic crossfade 70
B
buffers 73
C
catalog 97
adding sounds 101
closing 98
delete item 102
deleting 100
exiting 100
MIDI stop 104
MIDI trigger 102
modify item 102
opening 98
options 104
play queue 104
playing 103
resize item 103
saving 99
chase 113
clipboard 35, 47, 49
playing 49
selection 49
clipping level 70
close
catalog 98
playlist 114
soundfile 41
control buttons
automatic crossfade 34
copy 34
looped playback 34
paste 34
selection 34
zoom 34
copy 47
copy paste 47, 95
crossfade
automatic 70
control button 34
manual 56
cut 47

D
delete 41, 47
catalog 100
editlist 45
playlist 115
dialog
mix 20
recording 28
save as 12
DirectX plug-ins 60
display menu 89
display options 70
drop marker 63
E
edit cursor 36, 95
end 37
home 37
moving 36
play from 51
snap to play cursor 51
edit history 67
edit menu 81
editlist 44
load 45
save 44
EQ 58
exit
catalog 100
Fast EdDit 45
playlist 115
F
fade 53
using markers 55
file menu 79
G
gain change 59
gearshift 57
H
help 78
help menu 93
I
insert silence 48
L
load editlist 45
lock waveforms 37

Loop Playback 52, 85
M
main screen
control buttons 34
manual crossfade 56
marker 63
deleting 63
drop 63
drop during recording 42
in fades 54
jump to 37
moving 63
naming 63
saved in editlist 63
view/modify 63
marker menu 88
memory options 73
menu
display 89
edit 81
file 79
help 93
marker 88
options 91
play 84
tools 86
metasample 73
midi device 72
MIDI trigger
catalog playback 102
MIDItasker 102
mixing 53
modify window 32, 33, 46
mono/stereo 69
mouse
pointers 36
move 47
Multiple Clipboards 24
mute 48
N
new 41
next splice 49
normalize 59
ns 34
O
open
catalog 98
for modify 39
for read only 39

playlist 114
options
catalog 104
playlist 119
options menu 91
P
paste 47
pausing playback 51
play cursor 51
play enable 103
play menu 84
playback 51
audition 51
audition time 69
buffers 73
clipboard 52
drop marker 63
pausing playback 51
selected area 51
soundfile 51
stopping 51
while recording 43
window 51
playlist 111
add region 112
add soundfiles 112, 115
chase 113
closing 114
delete region 115
deleting 115
exiting 115
insert region 115
opening 114
options 119
playing 112
regions 112, 117
replace region 115
saving 114
SMPTE 113
start time 113, 116
plug-ins, DirectX 60
previous splice 49
punch in 48
R
read only window 32, 33, 46
record 42
buffers 73
drop marker 63
elapsed time 42
levels 42

options 44
while playing 43
Recording time 43
regions 112
replace 47
reverse 57
S
sample rate 69
sample size 69
save
catalog 99
playlist 114
soundfile 40
save as 40
save editlist 44
scroll bar 65
scrolling 65
scrub 52
scrub time 69
select all 47
selection 46, 95
beginning 46
end 46
mouse 46
shortcuts 95
silence
insert 48
mute 48
simultaneous play/record 43
SMPTE 113
soundfile directory 72
splice point 37, 49
T
temporary files 72
time display 4
time, recording 43
title bar 32
tools menu 86
transport bar 33
U
undo 50, 67
V
view selection 65
W
waveform
scrolling 65
waveform device 72

window
active 33, 46
modify 32, 46
read only 32, 46
Z
zoom 65
by factor of 10 65
by factor of 2 65
zoom-in time 65, 70

